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JFormDesigner

Introduction

JFormDesigner is an innovative GUI designer for Java Swing user interfaces. Its outstanding support for
JGoodies FormLayout, GroupLayout (Free Design), TableLayout and GridBagLayout makes it easy to
create professional looking forms.

JFormDesigner is available in four editions: as stand-alone application and as IDE plug-ins for Eclipse,
Intelli] IDEA and JBuilder. This documentation covers all editions. If there are functional differences
between the editions, then they are marked with: Stand-alone, Eclipse plug-in, IntelliJ IDEA plug-in
, JBuilder plug-in or IDE plug-ins.

Key features

Easy and intuitive to use, powerful and productive

JFormDesigner provides an easy-to-use but powerful user interface. Easily drag and drop
components, resize components, set properties, etc. Powerful features like in-place-editing, drag
and drop of columns/rows, bean morphing, layout manager changing increase your productivity.

IDE plug-ins and stand-alone application
JFormDesigner is available as IDE plug-ins for Eclipse, IntelliJ IDEA and JBuilder and as
stand-alone application.

GrouplLayout (Free Design) support

Grouplayout support brings the "Free Design" paradigm to JFormDesigner (as in NetBeans GUI
Builder; formerly Project Matisse). You can lay out your forms by simply placing components
where you want them. Visual guidelines suggest optimal spacing, alignment and resizing of
components. This makes it easy to design professional-looking GUIs.

JGoodies FormLayout and TableLayout support

These open-source layout managers allow you to design high quality forms. JGoodies FormLayout
support includes column/row specifications (alignment, size, resize behavior), IntelliGap
(automatically handles gap columns/rows) and column/row grouping (makes widths/heights
equal). Also other parts of the JGoodies Forms framework are supported (DLU borders, component
factory). TableLayout is fully supported (column/row size, gaps, alignment).

Advanced GridBagLayout support

The advanced GridBaglLayout support allows the specification of horizontal and vertical gaps (as in
TableLayout). JFormDesigner automatically computes the Gri dBagConstrai nts. i nsets for all
components. This makes designing a form with consistent gaps using GridBagLayout much easier.
No longer wrestling with Gri dBagConstrai nts.insets.

Column and row headers

The column and row headers (for grid-based layout managers) show the structure of the layout
(including column/row indices, alignment, growing, grouping) and allow you to insert or delete
columns/rows and change column/row properties. It's also possible to drag and drop columns/rows
(incl. contained components and gaps). This allows you to swap columns or move rows in seconds.

Localization support

Localizing forms using properties files has never been easier. Specify a resource bundle name and
a prefix for keys when creating a new form and then forget about it. JFormDesigner automatically
puts all strings into the specified resource bundle (auto-externalizing). It also updates resource
keys when renaming components, copies resource strings when copying components and removes
resource strings when deleting components.

You can also externalize and internalize strings, edit resource bundle strings, add locales, switch
locale used in Design view, in-place-edit text of current locale.

Java code generator or runtime library

Either let JFormDesigner generate Java source code for your forms (the default) or use the
open-source (BSD license) runtime library to load JFormDesigner XML files at runtime. Your choice.
Turn off the code generator in the Preferences, if you don't need it.

Generation of nested classes

The Java code generator is able to generate and update nested classes. You can specify a class
name for each component in your form. This allows you to organize your source code in an
object-oriented way.
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1 What's New in JFormDesigner 4.0

JFormDesigner 4.0 introduces several new features and enhancements. This topic describes some of the
significant or more interesting changes. Please have a look at the changelog for a complete list of

changes.
GroupLayout Support for GroupLayout brings the "Free Design" paradigm to JFormDesigner. You can lay out your
(Free Design) forms by simply placing components where you want them. Visual guidelines suggest optimal
support spacing, alignment and resizing of components. This makes it easy to design professional-looking
GUIs.
Animation
[] Anirmate layout changes in Design view
—a—n
animation speed: - () Fast 87 defaulte) slow
§——a——n
Other
[] Buffer Design view in video memary
LUnda histary size: 1.000 %
GroupLayout has been developed by the NetBeans team and is also used by the NetBeans GUI
Builder (formerly Project Matisse).
JGoodies JGoodies FormLayout 1.2 provides a new string syntax for encoded column and row specifications,
Forms 1.2 which allows JFormDesigner to generate much shorter Java code. Just two strings, compared to the
support complex expressions that were necessary for FormLayout 1.1.

FormLayout 1.1:

SeCLayout (new Formlayout |
new ColusmSpec[] (
new ColumnIpec | "max (defaulc:3041a] 7},
FormFactory. LASEL COMPONENT GAP COLSPEC,
new ColumnSpec | "max (defaulc: 100dlu) rgrow"),
FormFactory. LASED . :'.'f.'H.‘-’I".'\'.'.'i“T_ oA F_ COLSPEL,
FormFactory. DEFAVLT COLSFPEC

new RowSpeo(]
FormFactocy . DEFALT T_RC'EE;'.'F’EC_.
FormFactocy . [INE_G.J.P_ ROWRSPEC,
FormFacrvory .. DEFALT T_RC'&':TPEC_.
FormFactory.LINE GAD ROWSPEC,
FormFactory. IEFAVLT ROWNGFEC,
FormFactory. PARAGRAPH GAF ROWSPEC:
FormFactory. DEFAVLT RONSPEC,
FormFactory.LINE GAF EOWSFEC,
FormFactory. DEFAVLT RONSPEC,
FormFactory.LiNE GAF RORSFEC,
FormFactory. DEFALVLT RONSFPEC,
FormFactocy. LINE_GA!—’_ ROWEPRPEL,
FormFactocy . DEFALL T_RMS'F'EC,
FocmFactacy. EINE_-‘.-L-IP_ ROWSPELC,
FormFastary .. DEFALT T_RM'SPEC

IR

FormLayout 1.2:

SecLayout [new Formlayout |
"[50d1u, detault] . §loegap, [100dluw, defaulc] igrow, $logap, defaulc'™,
"z ® |default, §lgap), default, Spgap, 47 (default, $lgap), defaultc™)):

To upgrade Java code of existing forms to FormLayout 1.2, invoke the JFormDesigner Java code
generator once from command-line. If you prefer to use an older JGoodies Forms version, specify it
in the FormLayout preferences.
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Improved The improved conversion of IntelliJ IDEA forms now removes IDEA's GUI code (e.g. $$$setupUI$$$
IntelliJ IDEA method and component fields) and also uses the same modifiers (public, private, protected, etc) for
form the new component fields as the removed fields. This makes the migration from IntelliJ IDEA GUI
conversion builder to JFormDesigner seamless. IntelliJ IDEA plug-in and Eclipse plug-in only.
Abeille form JFormDesigner can now convert Abeille forms (.jfrm and .xml) to JFormDesigner forms.
conversion
Improved The "Choose Bean" dialog now updates its class name cache in the background. You can
"Choose Bean" immediately start typing your search criteria or select a class.
dialog

@ Choose Bean [5_<|

Choose a JavaBean

Select the class name of a JavaBean that you want to add ko the Form,

Search | JARs

Search For class name (7 = any character, * = any Skring):
i

Makching classes:

JEutkon (jas

ITree (javax, swing)

IXTaskPane (org.jdeskiop, swing:)
TxTaskPaneContainer (org., jdeskiop, swing:)
JxHyperlink (org. jdeskbop, swing:c) w

8]

‘",,: Scanning 'Dy\OpensSourceljava, netlswingxiclasses',

[] Add to palette category:

K l [ Zancel ] [ Classpath...

SwingX layout  Support for SwingX layout managers HorizontalLayout and VerticalLayout makes it easier to use
manager and SwingX components (like JXTaskPaneContainer and JXCollapsiblePane) in JFormDesigner. Also
border support SwingX's DropShadowBorder is fully supported.



http://www.swinglabs.org/
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Java Code Style The Java code generator now supports custom code indentation. The IDE plug-ins are using the IDE

code style settings of the project or workspace. The stand-alone edition provides a new Code Style
preferences page.

@ preferences @

----- General | Code style |
----- FormLayout {JGoodies)
..... null Layouk Indentation

----- Localization i --A
Indent size: 4

----- Look and Feels =

=-Java Code Generator Tab size:

= s Slecs IUse tab characker
P Layout Managers
----- Dcallzatlun other
Line separator: | PlatForm Default * | (applies to new files only)

Command-line
Java code
generation

You can now invoke the JFormDesigner Java code generator from command-line if necessary. This
helps you to upgrade your forms code to JGoodies FormLayout 1.2, which introduced a new much
shorter syntax for encoded column and row specifications.

Localization:
Safer deletion
of messages
from resource
bundles

The new Localization preferences option "Delete messages only if key prefix is equal to form's key
prefix", which is on by default, avoids removal of shared messages.

@ preferences E]

----- General | Localization |
----- FormLayout {J5oodies)
----- rull Layout Rename resource keys when renaming components

acalization

—opy localized messages when copying components

----- Look and Feels
=-Java Code Generator Delete localized messages when deleting components
""" Templates Delete localized messages when internalizing strings
- SOl [ Delete messages anly iF key prefix is equal ko Form's key prefix ]
i-Localization
“Code Skyle Insert new messages: | nexk bo similar keys (ascending order) w |
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This is the main window of JFormDesigner stand-alone edition:

& JFormDesigner 3.0 - MyProject

Fie Edt Wew Form Window Help

= W " - @
T Structure FH B2 b
= (tormn -

EFEitiis [Formlaycit]
=7 goodiesForms Separator2 (" Ger

40 lsbet ("Company
17 testFigicn
ﬁ label? (“Contact)
1 teaFielolz
":i:ir goodiesFormsSeparator] ("Froj e
& >
[ Properties W
Mame Wallg
Hame iz
Class JPanel
* Layout FormlLayout [mght:d...
background [] 235, 233, M6
| border
foreground W niack
tool TipTexd

e -w - HEgowsd BB X0 - [Wnkws T
q Paiette E B " FormeTutoral
[ seectionmose || 01l 3 & olls 7
_i Morquee Selection| | 1 General .

@ Choose Besh... 2 Beea

[= Components .

8 ritact

ol JLabel A e

-ij-m:dmd ;b - .

-1 JComboBox

9 FTI i) Sivarar (K]

1 JButtan L

& JcheckBox " R fmen] s ]

¥ JRedoButton

I Moogesution

[ setares

F JFormatiedT ... =

0 Containesr=

20 Windows

20 Menus

(1 JGoodies

Proparties | Code Ganeration

licensed 10 Karl Tauber

The main window consists of the following areas:

Main Menu: Located at the top of the window.

Toolbar: Located below the main menu.

Palette: Located at the left side of the window.

Design View: Located at the center of the window.
Structure View: Located at the upper right of the window.
Properties View: Located at the lower right of the window.

Error Log View: Located below the Design view. This view is not visible in the above screenshot.
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You can invoke most commands from the main menu (at the top of the main frame) and the various
context (right-click) menus.

Main Menu

The main menu is displayed at the top of the JFormDesigner main window of the stand-alone edition.

File:

Edit  Yiew Form Window  Help

File menu

()

=

[

F$

New Project
Open Project
Reopen Project
Project Properties

Close Project

New Form
Open Form

Reopen Form
Close
Close All

Save

Save As

Save All

Import

Exit

Edit menu

&
%
of

L&)

Undo
Redo
Cut

Copy
Paste

Rename

Delete

Creates a new project.

Opens an existing project.

Displays a submenu of previously opened projects. Select a project to open it.
Displays the project properties.

Closes the active project.

Creates a new form.

Opens an existing form.

Displays a submenu of previously opened forms. Select a form to open it.
Closes the active form.

Closes all open forms.

Saves the active form and generates the Java source code for the form (if Java Code
Generation is switched on in the Preferences).

Saves the active form under another file name or location and generates the Java source
code for the form (if Java Code Generation is switched on in the Preferences).

Saves all open forms and generates the Java source code for the forms (if Java Code
Generation is switched on in the Preferences).

Imports NetBeans, IntelliJ IDEA or Abeille form files and creates new JFormDesigner
forms. Use File > Save to save the new form in the same folder as the original form file.
This also updates the .java file.

Exits JFormDesigner. Mac OS X: this item is in the JFormDesigner application menu.

Reverses your most recent editing action.

Re-applies the editing action that has most recently been reversed by the Undo action.
Cuts the selected components to the clipboard.

Copies the selected components to the clipboard.

Pastes the components in the clipboard to the selected container of the active form.

Renames the selected component.

Deletes the selected components.



View menu
[=] Show Diagonals

Squint Test

éh Refresh

Form menu

{2} TestForm

Localize

L

New Locale

€

Delete Locale

.-.
4y

@ Internalize Strings

Ji| Generate Java Code

Window menu
Activate Designer

Activate Structure

@ m &

Activate Error Log

Next Form
Previous Form

Preferences

Help menu

{(7) Help Contents
What's New
Tip of the Day
Register
License

About

@ Externalize Strings

Activate Properties
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Shows diagonals.

Simulates evaluating a graphic layout by squinting your eyes. This tests legibility and
whether the overall layout is a strong, clear layout. You can change the squint intensity in
the Preferences.

Refresh the Design view of the active form. Reloads all classes used by the form and
recreates the form preview shown in the Design view. Use this command, if you changed
the code of a component used in the form to reload the component classes.

Tests the active form. Creates live instances of the form in a new window. You can close
that window by pressing the Esc key when the window has the focus. If your form
contains more than one top-level component, use the drop-down menu in the toolbar to
test another component.

Edit localization settings, resource bundle strings, create new locales or delete locales.
Creates a new locale.
Deletes an existing locale.

Moves strings to a resource bundle for localization. Use this command to start localizing
existing forms.

Moves strings from a resource bundle into the form and remove the strings from the
resource bundle.

Generates the Java code for the active form. Normally it's not necessary to use this
command because when you save a form, the Java code will be also generated.

Activates the Design view.

Activates the Structure view.
Activates the Properties view.

Activates the Error Log view. By default, the Error Log view is not visible. It automatically
appears if an error occurs.

Activates the next form.
Activates the previous form.

Opens the Preferences dialog. Mac OS X: this item is in the JFormDesigner application
menu.

Displays help topics.

Displays what's new in the current release.
Displays a list of interesting productivity features.
Activates your license.

Displays information about your license.

Displays information about JFormDesigner and the system properties.
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Context menus

Context menus appear when you're right-click on a particular component or control.

Design view context menu:

u [
mlame: —
e H align: |Cefadl | =

Phaone: ' . _— Qﬁ 5
PIF | City: oo [oefeok] *F* [nighe]
‘ v Set labelFaor P =
courktry: dd Event Handler P
Maorph Bean...
Mest in JPanel
of Cut Strg-+
12 Copy Skrg+C
I Faste Strg+¥
Rename. .. Fz
¥ Delete Entf

Properties view context menu:

B
Mame Salue
Hame narmeLakel
Class JLahel
HConstraints 1,1,1,1, DEFAULT, D

ault Yalue

dizplayediine =

displayeddne  E3 Set value to nul ||
enakled
Externalize Skrin —
fart o= - ]
fareground @ Internalize String
| horizontalAlig ™, Mo Java Code | |
icon —
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2.2 Toolbars

Toolbars provides shortcuts to often used commands.

Main Toolbar

This is the toolbar of JFormDesigner stand-alone edition. Many of the commands are also used in the
toolbars of the IDE plug-ins.

S| (JE-

b

New Project
Open Project

Project Properties

s+ B0 E

New Form

Open Form

ﬁ:

|| save
um_l Save All

< Undo
" Redo
of Cut

Copy

Paste
Delete

Test Form

& X

Windovys W

[=] Show Diagonals

Squint Test

éh Refresh

0 German [Austria) v

@ Localize

Ji| Generate Java
Code

{(7) Help Contents

|.;:;J "'l.m.l ‘(Ir':1 '-'f." = *x O * [ iindoves w

T | ™ cermanid.. v @ - [ (3

Creates a new project.

Opens an existing project.
Displays the project properties.
Creates a new form.

Opens an existing form.

Saves the active form and generates the Java source code for the form (if Java Code
Generation is switched on in the Preferences).

Saves all open forms and generates the Java source code for the forms (if Java Code
Generation is switched on in the Preferences).

Reverses your most recent editing action.

Re-applies the editing action that has most recently been reversed by the Undo action.
Cuts the selected components to the clipboard.

Copies the selected components to the clipboard.

Pastes the components in the clipboard to the selected container of the active form.
Deletes the selected components.

Tests the active form. Creates live instances of the form in a new window. You can close
that window by pressing the Esc key when the window has the focus. If your form contains
more than one top-level component, use the drop-down menu to test another component.

Allows you to change the look and feel of the components in the Design view. You can add
other look and feels in the Preferences.

Shows diagonals.

Simulates evaluating a graphic layout by squinting your eyes. This tests legibility and
whether the overall layout is a strong, clear layout. You can change the squint intensity in
the Preferences.

Refresh the Design view of the active form. Reloads all classes used by the form and
recreates the form preview shown in the Design view. Use this command, if you changed the
code of a component used in the form to reload the component classes.

Allows you to change the locale of the form in the Design view. "(no locale)" is show if the
form is not localized. Use Form > Externalize Strings to start localizing a form.

Edit localization settings, resource bundle strings, create new locales or delete locales.

Generates the Java code for the active form. Normally it's not necessary to use this
command because when you save a form, the Java code will be also generated.

Displays help topics.

-10 -
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2.3 Design View

This view is the central part of JFormDesigner. It displays the opened forms and lets you edit forms.

[ addressPanel
om =+ =] [ e T an)

[ | | | I I | ]
1| |General
2 Catmpaty
5 Cortact
7 .H‘rupeller "
a PTI k] Sovver [k
11 R [rrirn] D [trien]

| | | | |

Stand-alone: At top of the view, tabs are displayed for each open form. Click on a tab to activate a
form. To close a form, click the ¥ symbol that appears on the right side of a tab if the mouse is over it.
An asterisk (*) in front of the form name indicates that the form has been changed.

IDE plug-ins: The Design view is integrated into the IDEs, which have its own tabs.

On the left side of the view and below the tabs, you can see the column and row headers. These are
important controls for grid-based layout managers. Use them to insert, delete or move columns/rows and
change column/row properties.

In the center is the design area. It displays the form, grids and handles. You can drag and drop
components, resize, rename, delete components or in-place-edit labels.

Selecting components

To select a single component, click on it. To select multiple components, hold down the Ctrl (Mac OS X:
Command) or Shift key and click on the components. To select the parent of a selected component,
hold down the Alt key (Mac OS X: Option key) and click on the selected component.

To select components in a rectangular area, select Marquee Selection in the Palette and click-and-drag
a rectangular selection area in the Design view. Or click-and-drag on the free area in the Design view. All
components that lie partially within the selection rectangle are selected.

Propeller
—un—nl L] o g u u

a7 AT
T S

The selection in the Design view and in the Structure view is synchronized both ways.

Drag feedback

JFormDesigner provides four types of drag feedback.

7IP £ City: ame: “pidrth 1
West East
% hone: ["‘\".S n [% n
< Pty 2 o 9

columnn 1, row 7 colur g = |Center

-11 -
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The gray figure shows the outline of the dragged components. It always follows the mouse location. The
green figure indicates the drop location, the yellow figure indicates a new column/row and red figures
indicate occupied areas.

Move or copy components

To move components simply drag them to the new location. You will get reasonable visual feedback
during the drag operation.

II—I—II“
AN -

@

To copy components, proceed just as moving components, but hold down the Ctrl key (Mac OS X:
Option key) before dropping the components.

You can cancel all drag operations using the Esc key.

Resize components

Use the selection handles to resize components. Click on a handle and drag it.

# = = = L

Marme: 1

“hone: 1 +—*

ZIP f City: [width 3, height 1 (+2, 0} ]

The green feedback figure indicates the new size of the component. The tool tip provides additional
information about location, size and differences.

Whether a component is resizable or not depends on the used layout manager.

Morph components

The "Morph Bean" command allows you to change the class of existing components without loosing
properties, events or layout information. Right-click on a component in the Design or Structure view and
select Morph Bean from the popup menu.

Nest in Container

The "Nest in Container" command allows you to nest selected components in a new container (usually a
JPanel). Right-click on a component in the Design or Structure view and select Nest in JPanel from the
popup menu. The new container gets the same layout manager as the old container and is placed at the
same location where the selected components were located. For grid-based layout managers, the new
container gets columns and rows and the layout constraints of the selected components are preserved.

u] 1 2 u] 1

I S o L n ' n
0| Epeed: ®(3) DSLEa() SDN® |0 Speed: ®G) DsL || () SO e
| | | | | |

-12 -
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Non-visual beans

To add a non-visual bean to a form, select it in the Palette (or use Choose Bean) and drop it into the
free area of the Design view. Non-visual beans are shown in the Design view using proxy components.

[ | | ]
@
addressOhject
—n
Red beans

If a bean could not instantiated (class not found, exception in constructor, etc), a red bean will be shown
in the designer view as placeholder.

com ktauber test beans MyPanel ot ktauber test beans MyLakbel

To fix such problems, add required jars to the classpath in the Project dialog and then select View >
Refresh from the menu (or press F5) to refresh the designer view.

2.3.1 Headers

The column and row headers (for grid-based layout managers) show the structure of the layout. This
includes column/row indices, alignment, growing and grouping.

= 1 = 2
1| Name:
3| Phanhe:

Use them to insert, delete or move columns/rows and change column/row properties. Right-clicking on a
column/row displays a popup menu. Double-clicking shows a dialog that allows you to edit the
column/row properties.

1 ([ 3 5 If a column width or row height is zero, which is the case if a column/row is empty, then
JFormDesigner uses a minimum column width and row height. Columns/rows having a minimum
1) text size are marked with a light-red background in the column/row header.

Selecting columns/rows

You can select more than one column/row. Hold down the Ctrl key (Mac OS X: Command key) and click
on another column/row to add it to the selection. Hold down the Shift key to select the columns/rows
between the last selected and the clicked column/row.

Insert column/row

Right-click on the column/row where you want to insert a new one and select Insert Column / Insert

Row from the popup menu. The new column/row will be inserted before the right-clicked column/row. To
add a column/row after the last one, right-click on the area behind the last column/row.

-13-
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If the layout manager is FormLayout, an additional gap column/row will be added. Hold down the Shift
key before selecting the command from the popup menu to avoid this.

Besides using the popup menu, you can insert new columns/row when dropping components on
column/row gaps or outside of the existing grid. In the first figure, a new row will be inserted between
existing rows. In the second figure, a virtual grid is shown below/right to the existing grid and a new row
will be added.

u] 1 u] 1
O Makme: O Makme:
1 Jhn:lé-;;} 1] hone:
[

Delete columns/rows

Right-click on the column/row that you want delete and select Delete Column / Delete Row from the
popup menu.

If the layout manager is FormLayout, an existing gap column/row beside the removed column/row will
also be removed. Hold down the Shift key before selecting the command from the popup menu to avoid
this.

Split columns/rows

Right-click on the column/row that you want split and select Split Column / Split Row from the popup
menu.

If the layout manager is FormLayout, an additional gap column/row will be added. Hold down the Shift
key before selecting the command from the popup menu to avoid this.

Move columns/rows

The headers allow you to drag and drop columns/rows (incl. contained components and gaps). This
allows you to swap columns or move rows in seconds. Click on a column or row and drag it to the new
location. JFormDesigner updates the column/row specification and the locations of the moved
components.

Matme:
2| Phohe:
S ey
7 Country:

If the layout manager is FormLayout, then existing gap columns/rows are also moved. Hold down the
Shift key before dropping a column/row to avoid this.
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Resize columns/rows

To change the (minimum) size of a column/row, click near the right edge of a column/row and drag it.

E 4 G @ &
1] Mame: iclth 40l
) Hink: Press Chel ko set minimum size
3| Phone:
5| ZIP J City:

FormLayout supports minimum and constant column/row sizes. Hold down the Ctrl key to change the
minimum size. TableLayout supports only constant sizes and GridBaglLayout supports only minimum
sizes.

Header symbols

Following symbols are used in the headers:

Column Header
' Left aligns components in the column.
= Right aligns components in the column.
s« Center components in the column.
=  Fill (expand) components into the column.
b Grow column width.

@ Group column with other columns. All columns in a group will get the same width.

Row Header
+ Top aligns components in the row.
+ Bottom aligns components in the row.
¥ Center components in the row.
¥ Fill (expand) components into the row.

a Baseline aligns components in the row.

Jo

Aligns components above baseline in the row.

Aligns components below baseline in the row.

1]

T Grow row height.

@ Group row with other rows. All rows in a group will get the same height.

2.3.2 In-place-editing

In-place-editing allows you to edit the text of labels and other components directly in the Design view.
Simply select a component and start typing. JFormDesigner automatically displays a text field that allows
you to edit the text.

Fourin[ 1§

You can also use the Space key or double-click on a component to start in-place-editing. Confirm your
changes using the Enter key, or cancel editing using the Esc key.

| |

In-place-editing is available for all components, which support one or the properties t ext Wt hvnhenoni c,
text andtitle.
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In-place-editing is also supported for the title of Ti t | edBor der and the tab titles of JTabbedPane.

[ |
. ptiu:uns Advanced

Marme:

Matne:
hone;

Ti t | edBor der : double-click on the title of the Ti t | edBor der ; or select the component with the
Ti t | edBor der and start in-place-editing as usual.

JTabbedPane: double-click on the tab title; or single-click on the tab, whose title you want to edit and
start in-place-editing as usual.

2.3.3 Keyboard Navigation

Keyboard navigation allows you to change the selection in the designer view using the keyboard. This
allows you for example to edit a bunch of labels using in-place-editing without having to use the mouse.
You can use the following keys:

Key Description

Up move the selection up
Down move the selection down
Left move the selection left
Right move the selection right
Home select the first component
End select the last component

Note: Keyboard navigation is currently limited to one container. You cannot move the selection to
another container using the keyboard.

2.3.4 Menu Designer

The menu designer makes it easy to create and modify menu bars and popup menus. It supports
in-place-editing menu texts and drag-and-drop menu items.

Menu bar structure
The following figure shows the structure of a menu bar. The horizontal bar on top of the image is a

JMenuBar that contains JMenu components. The JMenu contains JMenul t em, JCheckBoxMenul t em
JRadi oBut t onMenul t emor Menu Separator components. To create a sub-menu, put a JMenu into a JMenu

IMenu  IMenu

IMenultem
JMenultem

IMenultem
IMenultem IMenultemn

IMenultem

The component palette has a category "Menus" that contains all components necessary to create menus.
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Creating menu bars

To create a menu bar:

1. add a JMenuBar to a JFrane
2. add JMenus to the JMenuBar and
3. add JMenul t ens to the JMenus

Select the necessary components in the Palette and drop them to the Design view.

|y |
index 0

You can freely drag and drop the various menu components to rearrange them.

Creating popup menus

To create a popup menu:

1. add a JPopupMenu to the free area in the Design view and
2. add JMenul t ens to the JPopupMenu

Marne: | | Undao |
| |
Cuk

Copy
Paste
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Assign popup menus to components

If you use Java 5 or later, you can assign the popup menu to a component in the properties view using
the "componentPopupMenu" property. Select the component to which you want attach the popup menu
and assign it in the Properties view. Note that you must click on the Show Advanced Properties in the
toolbar of the Properties view to see the property.

&= Properties |:=:D| £y |
Mame Yalue
componentOrient.ation LMK r.
componentPopuohany {detaulk) w
cursor {default)
disabledTextColor (rione)
doubleBuffered

E wopupiMeno 1
dragEnabled e F gl k

Note that JFormDesigner must run on Java 5 to use the "componentPopupMenu" property. Open the
JFormDesigner About dialog and check whether it displays "Java 1.5.x".

2.3.5 Button groups

Button groups (j avax. swi ng. But t onG oup) are used in combination with radio buttons to ensure that
only one radio button in a group of radio buttons is selected.

{:} preferred [ I T =5 1

O rrinirmLrT O I'Eﬁ: O EEI"ITEI’ D [ight L{E}ﬂd
il i F .
) pixel |:@ detault O preferred O minirmLm
1::} perg:_enti\\gedl () constart I}S

To visualize the grouping, JFormDesigner displays lines connecting the grouped buttons.

Group Buttons

To create a new button group, select the buttons you want to group, right-click on a selected button and
select Group Buttons from the popup menu.

u) prefer
!—El.— Horizontal alignment b
") minitri.
R ‘Wertical alignment »
80 orow
i Add Event Handler ]
) pixelm
=N Marph Bean...
=) percel ”
u 5 Mest in JPanel
ks el

You can extend existing button groups by selecting at least one button of the existing group and the
buttons that you want to add to that group, then right-click on a selected button and select Group
Buttons from the popup menu.

Note that the Group Buttons and Ungroup Buttons commands are only available in the context menu

if the selection contains only components, which are derived from JToggl eBut t on (JRadi oButt on and
JCheckBox).
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Ungroup Buttons

To remove a button group, select all buttons of the group, right-click on a selected button and select
Ungroup Buttons from the popup menu.

To remove a button from a group, right-click on it and select Ungroup Buttons from the popup menu.

ButtonGroup object

Button groups are non-visual beans. They appear at the bottom of the Structure view and in the Design
view. JFormDesigner automatically creates and removes those objects. You can rename button group
objects.

“2 Structure =
pixellakel ("pizel") i
* percentageButton ("percientage"

.I_.;. percentageFisld

percentagelakel ("9

e the association to the button group in the Properties view.

Matne Yalue
Hame prefEutton
inButton

Class JxFad
Button Group {

FConstraints

2.3.6 JTabbedPane

JTabbedPane is a container component that lets the user switch between pages by clicking on a tab.

After adding a JTabbedPane to your form, it looks like this one:

To add pages, select an appropriate component (e.g. JPanel) in the palette, move the cursor over the
tabs area of the JTabbedPane and click to add it.

s | rex §|
\hi:' oo (F )
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You can see only the components of the active tab. Click on a tab to switch to another page. To change a
tab title, double-click on a tab to in-place-edit it. You can edit other tab properties (tool tip text, icon, ...)
in the Properties view. Select a page component (e.g. JPanel) to see its tab properties.

W
alue
parel -
JPanel i
[+ L ayrourt FarmLayout [defau. ..
Tab Title eneral
Tak ToolTip
Tak lcon
Tab Dizabled lcon
Tab Mnermonic
Tab Mnemonic Index| -1 _3
Tab Enabled true
backgroumnd [ 238, 233, 26
lhinkrder \:
Properties | Code Generstion

To change the tab order, select a page component (e.g. JPanel) and drag it over the tabs to a new place.
You can also drag and drop page components in the Structure view to change its order.

teat | text F@ﬂ
| |
@ 1

- Lo

Use an empty border to separate the page contents from the JTabbedPane border. If you are using
JGoodies Forms, it's recommended to use TABBED DI ALOG BORDER. Otherwise use an Enpt yBor der .

[text [1ext (et [ et
[ext bt
et bt
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Components can provide events to signal when activity occurs (e.g. button pressed or mouse moved).
JFormDesigner shows events in the Structure view and event properties in the Properties view.

"% Structure = e
B [farmm)
= [ this [GridEagLayout]
1 textField
= E¥ browseButton ("Browese.. ")

s dactionPerformed - broveseButtonActionPerformed
= Properties :::9 :':P @:
Marme Walue

Listener ActionListener (java.awt.eve. .
Listener Method actionPerformed

Handler Method hrovwwseButton&ctionPerformed
Pazs parameters |:| falze

Propetties | Code Generstion

IDE plug-ins: Double-click on the event in the Structure view to go to the event handler method in the
Java editor of the IDE.

Add Event Handlers

To add an event handler to a component, right-click on the component in the Design or Structure view
and select Add Event Handler from the popup menu. The events popup menu lists all available event
listeners for the selected components and is divided into three sections: preferred, normal and expert
event listeners.

H aligr; |Defautt| «

Waligr: |Defaut| + % o 3

&dd Event Handler

@4 actionPerformed (ActionListener). ..

- Marph Bean... @¢ caretUpdate (CaretListener), ..
Mest in JPanel J".p;.]. PropertyChangeListener ]
of Cut Chrl+3 p
o .
= ‘i3 Ancestorliskenar b
= Copy Chrl4+iC . .
[EI ® ComponentListengr »
’?’@ ContainerListener k
Rename... Fz
“4g FocusListener ) @4 focusGained. ..
3 Delete Delete o h
“& HierarchyBoundsListener J @4 focusLost.,,
%3 HigrarchyListener ] ‘
4#-1 TrrniFMakhadAl ickanar Y

F-S
The & jcon in the popup menu indjcates that the listener interface will be implemented (e.g.
javax.swing.ChangelListener). The @ icon indicates that the listener adapter class will be used (e.g.

java.awt.event.FocusAdapter for java.awt.event.FocusListener). The icons % and @ are used when the
listener is already implemented.
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After selecting an event listener from the popup menu, you can specify the name of the handler method
and whether listener methods should be passed to the handler method in following dialog.

€ Add Event Handler X

Add an event handler to selected components
Specify the name of the handler method,

Liskener class; java.awk, event, ActionListener

Liskener method: | ackionPerformed (ActionEvent)

Handler method: | browseButtonackionPerformed w
[] Pass listerer methad parameters to handler methad

o ko handler method in Java editor

(0] 4 l [ Cancel

If you add a Proper t yChangeli st ener, you can also specify a property name (field is not visible in above
screenshot). Then the listener is added using the method addPr oper t yChangeLi st ener (Stri ng
propertyNane, PropertyChangelLi stener |istener).

The "Go to handler method in Java editor" check box is only available in the IDE plug-ins.

Stand-alone: After saving the form, go to your favorite IDE and implement the body of the generated
event handler method.

If you use the Runtime Library and the Java code generator is disabled, you must implement the handler
method yourself in the target class. See documentation of method For nCr eat or . set Tar get () in the
JFormDesigner Loader API for details.

Remove Event Handlers

To remove an event handler, select it in the Structure view and press the Del key. Or right-click on the
event handler and select Delete from the popup menu.

Change Handler Method Name

Select the event handler in the Structure view, press the F2 key and edit the name in-place in the tree.
You can also change the handler method and the "pass parameters" flag in the Properties view.
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2.4 Palette

The component palette provides quick access to commonly used components (JavaBeans) available for

adding to forms.

[& Zelection Mode

[:, Marguee Selection
@ Choose Bean...
[-= Cormponerts

¥ JLabel -
T ITesdtField

ﬁ JCamboBox

= JBLttan
JCheckBox

(¢ JRadicButton s
= Cortainers

[ | JPanel S
"] ITabbedrane

Lh JScrollPane

[l | J=pltPane
JToolEar

@ JToolEar Se...  w
3 wimdowes

3 Menus

3 Joodies

Toolbar commands

[Gs]

The components are organized in categories. Click on a category header to expand or collapse
a category.

You can add a new component to the form in following ways:

% Select a component in the palette, move the cursor to the Design or Structure view and
click where you want to add the component.

% Select Choose Bean, enter the class hame of the component in the Choose Bean
dialog, click OK, move the cursor to the Design or Structure view and click where you
want to add the component.

To add multiple instances of a component, press the Ctrl key (Mac OS X: Command key) while
clicking on the Design or Structure view.

The component palette is fully customizable. Right-click on the palette to add, edit, remove or
reorder components and categories. Or use the Palette Manager.

Palette Manager Opens the Palette Manager dialog to customize the palette.
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Choose Bean

You can use any component that follows the JavaBean specification in JFormDesigner. Select Choose
Bean in the palette to open the Choose Bean dialog.

Search tab

On this tab you can search for classes. Enter the first few characters of the class you want to choose until
it appears in the matching classes list. Then select it in the list and click OK.

The matching classes list displays all classes that match. It is separated into up to three sections:

# Matching history: classes found in the history of last used classes. If the search field is empty, the
complete history is displayed. To delete a class from the history, select it and press the Delete key
or right-click on it an select Delete from the popup menu.

# Matching classes: classes found in the Classpath specified in the current Project.
® Matching palette: classes found in the palette.

@ Choose Bean @

Choose a JavaBean

Zelect the class name of a JavaBean that you vwant to add to the form.

| Search | JaRs
Search for class name (¥ = any character, * = any String):

b

Matching classes:

MWatching history

JButtan (jaw

Matching classes
JBasicDialogConfig (com formdey toolkit dislogs)
JBasicDialogTest
JBEutton (avas swing
JButtonBar (carm. formdey toolkit dialogs)

Matching palette
JButton (avax swing)

[] &dd to palette category: | |

[ Ik ] [ Cancel ] [ Claszpath...

-24-



JFormDesigner 4.0.2 Manual

JARs tab

On this tab you can select classes that are marked as JavaBean in the JAR's manifest. The provider of the
component JAR can mark some classes as JavaBean in the manifest file. Popular 3rd party component
libraries like MiG Calendar or JIDE components use this to make it easier to find the few classes, which
can be used in GUI builders, in libraries that contain hundreds of classes.

® Choose Bean @

Choose a JavaBean

Zelect the class name of a JavaBean that you vwant to add to the form.

Search | JARE |

Available JARS in classpath:

['fl jide-camman jar (L Yayvailibeyjice 192 053k
['fl jicle-cotmponents jar (O jsvatlibeiide. 1.9 2 03k

i migcalendarkean jar (0 jayvabiGCalendarilibg

JavaBeans in selected JAR:

Activity AShapeBean [com miginfocom heans)
DateAreaBean [com miginfocom bheans)
DateHeaderBean (cam. miginfocom heans)

DatePickerBean (com.miginfocom beans)
DetnoDataBeat [cotn miginfocom beans)
GridDimensionLayowBean (com miginfocom beans)

MarthiCategoryHeaderBean (com miginfocom beans)
WestCategoryHeaderBean (com miginfocom beans)

|:| A to palette category: | |

[ Ok ] [ Cancel ] [ Claszpath...

See also http://java.sun.com/j2se/1.5.0/docs/guide/jar/jar.html#Per-Entry%?20Attributes
Other options
The Is Container check box allows you to specify whether a bean is a container or not.

If you select Add to palette category, the component will be added to the palette category specified in
the following field. Click the New button to create a new category for your components if necessary.

Stand-alone: Use the Classpath button to specify the location of your component classes. Add your JAR
files or class folders.

IDE plug-ins: The classpath specified in the IDE project is used to locate component classes.
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Palette Manager

This dialog allows you to fully customize the component palette. You can add, edit, remove or reorder
components and categories.

@ palette Manager @

Manage the palette

Add, edit, remove and rearrange categories and beans.

Palette tems: [—]
& B
I"'g Swyitiy Palette b [ Mews Category... ]
= [3 Components
JLabel [ awing .JLakbel

Q.La e.ﬂavgxswmg_ abel) ) [ Addd Beanz. .. ]
II_I JTendField (javax . swing. JTexdField) =
ﬁ JCarmbaBox (avax swing JComboBox) Edit
3 JButton (javax zwing JEutton) =
M JcheckBox fjava swing JCheckBo:x) Refmove

(* |RadicButton (javax.zwing JRadioButton
LI_JTDggIEEIuttDn [iawvax. awing JToggleButton)

JTendArea (javax.awing JTextlres)
JFarmattedTextField (javax. wing JFormattedTextField)
JPazzwaoardField (javax.swing JPazswordField)
JTendPane (javax.awing JTextPane)

JEditorPane (javax swing JEditorPane)

JEpinner (avax.zwing JEpinner)

JList (javax.zwing JLizt)

JTable (javax. zwing.JTakle)

JTree (javax . swing JTree)

JProgressBar (javax.zwing JProgresszBar)

JEcrolBar (javax. zwing JScrollBar)

JSeparator (javax.swing JSeparator)

'@' Jslider (avax swing . JSlider)

@% Action (javax.swing AbstractLction)

k] Horizortal Spacer [com jformdesigner designer wrapper
E Wertical Spacer (com jfarmdesigner designer wwrapper W

oo B F 8 e 0

3 Cortainers =
3 wWindowes
3 Merus
3 JGoodies w
4 >
Uze drag and drop to rearrange tems.
[ [0],4 l [ Cancel
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2.5 Structure View

This view displays the hierarchical structure of the components in a form.

B | 2 Each component is shown in the tree with an icon, its name and
additional information like layout manager class or the text of a label or

ructure

E cforem) button. The name must be unique within the form and is used as
2 [ this [FormLayout)] variable name in the generated Java code.
50 nameLabel ("Marme:™)

You can edit the name of the selected component in the tree by

;[_' nametField pressing the F2 key. Right-click on a component to invoke commands
7 phoneLakel ("Phione:") from the context menu.
.]:_- phoneField
¥ ZipCityLabel ("ZIP 7 City) The selection in the Structure view and in the Design view is
471 zipField synchronized both ways.
= [ cityField

@8 keyTyped - cityFieldiey Typed
=) countryLabel ("Courtey:™)
= .]:_-'P countryField
@3 keyTyped - countryFieldiey Typed

The tree supports multiple selection. Use the Ctrl key (Mac OS X: Command key) to add individual
selections. Use the Shift key to add contiguous selections.

The tree supports drag and drop to rearrange components. You can also add new components from the
palette to the Structure view. Besides the feedback indicator in the structure tree, JFormDesigner also
displays a green feedback figure in the Design view to show the new location.

ructure = é‘?

E rfarm)

= ,5-] popuphlenu [JPopupiienu)
Unda = undaotterm ["Undo™
Redo = redoftem ("Redo”)
cut = separatar
Copy l%l cuttem "Cut™

= copyttem (MCopyt
Paste =1 pastettem [“Paszte’)
Delete = deletefiem ("Delciy )
\.‘-"3'

Various overlay icons are used in the tree to indicate additional information:

Icon Description

c] The component is bound to a Java class. Each component can have its own (nested) class. See Nested
Classes for details.

3 The component has events assigned to it. The events are shown as child nodes in the tree.

J The component has custom code assigned to it (see Code Generation tab in the Properties view). In the
above screenshot, the component zi pFi el d has custom code.

o The variable modifier of the component is set to publ i c. See Code Generation tab.
& The variable modifier of the component is set to def aul t .

e The variable modifier of the component is set to pr ot ect ed.

B The variable modifier of the component is set to pri vat e.

| A property (e.g. JLabel . | abel For) of the component has a reference to a non-existing component. This
can happen if you e.g. remove a referenced JText Fi el d. In the above screenshot, the component
phoneLabel has a invalid reference.
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Toolbar commands

+ Expand All Expand all nodes in the structure tree.
— Collapse All Collapse all nodes in the structure tree.
g Hide Events If selected, hides the events from the structure tree.
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2.6 Properties View

The Properties view displays and lets you edit the properties of the selected component(s). Select one or
more components in the Design or Structure view to see its properties. If more than one component is
selected, only properties that are in all selected components are shown.

The view consists of two tabs (at the bottom of the view).

Properties tab

The Properties tab displays the component name, component class, layout properties, client properties
and component properties. The list of component properties comes from introspection of the component
class (JavaBeans).

By default, the Properties view displays regular properties. To see expert

displayedinemonic

dizplayedinemonic...

-1

Properties | Code Generation

—+| —+l B
S 5 R . . o .
properties, click on the Show Advanced Properties (51) button in the
Mame Walue view toolbar and to see read-only properties, click the Show read-only
b |
Hame countrylabel Properties (+) button.
Class JLabel
HConstraints 1,71, 1, DEFALULT... | Different font styles are used for the property names. Bold style is used for
biackgrournd [] 236, 253, 216 preferred (often used) properties, plain style for normal properties and

italic style for expert properties. Read-only properties are shown using a
gray font color.

font M Sans Serif 11 The light gray background indicates unset properties. The shown values
f':'”f’gr':'””d : M black are the default values of the component. The white background indicates
horizontalAlignment | LEADING set properties. Java code will be generated for set properties only. Use
:cEan Restore Default Value (52) to unset a property. Use Set Value to null (
AbDelror |55 ..

B
toxt Courtry: ) from the popup menu to set a property explicitly to nul I .
toolTipText
verticalAlignmert CEMTER

The left column displays the property names, the right column the property values. Click on a property

value to edit it.

labelFor

toolTipText

Cu:uuntrg.-':|

(B

You can either edit a value directly in the property table or use a custom property editor by clicking on
the ellipsis button (E]) on the right side. The custom editor pops up in a new dialog. The globe button (E]
), which is only available for localized forms and string properties, allows you to choose existing strings

from the resource bundle of the form.

The type of the editor depends on the data type of the property. JFormDesigner has built-in property
editors for all standard data types.

For numbers, a spinner editor makes it easier to increase or decrease the value using the arrow buttons
or Up and Down keys. Press the Enter key to confirm the change; or the Esc key to cancel it.

background [] whike
16 [E2
editable krue

Common properties (at the top of the table):
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Property Name

Name

Class

Button Group

Layout

Constraints

Client Properties
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Description

The name of the component. Must be unique within the form. Used as variable name in the
generated Java code. It is also possible to specify a different variable name on the Code
Generation tab.

The class name of the component. The tooltip displays the full class name and the class
hierarchy. Click on the value to morph the component class to another class (e.g. JTextField
to JTextArea).

The name of the button group assigned to the component. This property is only visible for
components derived from JToggl eBut t on (e.g. JRadi oBut t on and JCheckBox).

Layout properties of the container component. Click on the plus sign to expand it. The list of
layout properties depends on the used layout manager. This property is only visible for
container components. Click on the value to change the layout manager.

Layout constraints properties of the component. Click on the plus sign to expand it. The list of
constraints properties depends on the layout manager of the parent component. This property
is only visible if the layout manager of the parent component uses constraints.

Client properties of the component. Click on the plus sign to expand it. This property is only
visible if there are client properties defined in the Client Properties preferences.

Code Generation tab

This tab displays properties related to the Java code generator.

Matne
Mested Class Mame

Yalue

Yariakble Mame

natmeLakel

Yariakble Modifiers

private

Uze Local Variable

true

Gen. etter Method

|:| falze

Yariahle Annotatio...

Type Parameters (J...

Custom Creation ...

Pre-Cresation Code

Post-Creation Code

Pre-Intialization Code

Post-Intialization ...

Properties | Code Generation

Property Name
Nested Class Name

Variable Name

Variable Modifiers

Use Local Variable

Gen. Getter Method

Variable Annotations
(Java b)

Type Parameters
(Java )

Description
The name of the generated nested Java class. See Nested Classes for details.

The variable name of the component used in the generated Java code. By default, it is equal
to the component name.

The modifiers of the variable generated for the component. Allowed modifiers: publ i c,
defaul t,protected, private,static andtransi ent. Defaultispri vate.

If t r ue, the variable is declared as local in the initialization method. Otherwise at class level.
Default is f al se.

If t r ue, generate a public getter method for the component. Default is f al se.

Annotations of component variable (Java 5).

Parameters of component type (Java 5). E.g. MyTypedBean<St ri ng>.
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Property Name Description

Custom Creation Custom code for creation of the component.
Code

Pre-Creation Code Code included before creation of the component.

Post-Creation Code Code included after creation of the component.
Pre-Initialization Code Code included before initialization of the component.
Post-Initialization Code included after initialization of the component.
Code

This is the dialog for custom code editing:

@ Custom Creation Code @

Custorn code for creation of the component.

ConponentFactory. createlabhel () ! i
w
£ »
Custom code averview: Ihzert Yariable =

<Pre-Creation CodeX

<Variable annotations>

JLabel namelLabel = <Custom Creation Code>
<Post-Creation Code:>

<Pre-Initialization Code>
namelabel setfomePropertyisoneWalue) -
<Post-Initialization Code>

Ok l [ Cancel

"(form)" properties

JFormDesigner 4.0.2 Manual

Select the "(form)" node in the Structure view to modify special form properties:

Properties tab

Property Name Description
Set Component If t r ue, invokes java.awt.Component.setName() on all components of the form.
Names
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Code Generation tab

Property Name

Generate Java
Source Code

Default Variable
Modifiers

Default Use Local
Variable

Default Gen. Getter
Method

Default Handler
Modifiers

Member Variable
Prefix

Use 'this' for member
variables

118n Initialization
Method

118n 'getBundle’
Template

118n 'getString’
Template

118n Key Constants
Class

Description

If true, generate Java source code for the form. Defaults to "Generate Java source code”
option in the Java Code Generator preferences.

The default modifiers of the variables generated for components. Allowed modifiers: publ i c,
defaul t,protected, private,static andtransi ent. Defaultis pri vate.

If t r ue, the component variables are declared as local in the initialization method. Otherwise
at class level. Default is f al se.

If t r ue, generate public getter methods for components. Default is f al se.

The default modifiers used when generating event handler methods. Allowed modifiers:
public,defaul t,protected, private,final andstatic. Defaultis pri vate.

Prefix used for component member variables. E.g. "m_

If enabled, the code generator inserts 'this.' before all member variables. E.g. t hi s.
nanmelLabel . set Text (" Nane: ") ;

If enabled, the code generator puts the code to initialize the localized texts into a method
initComponentsi18n(). You can invoke this method from your code to switch the locale of a
form at runtime.

Template used by code generator for getting a resource bundle. Default is
Resour ceBundl e. get Bundl e( ${ bundl eNang})

Template used by code generator for getting a string from a resource bundle. Default is
${bundl e} . get Stri ng(${ key})

The name of a class that contains constants for resource keys.

2.6.1 Property Editors

Property editors are used in the Properties view to edit property values.

labelFor

toolTipTesxt

Couritry:|

(5] eed

You can either edit a value directly in the property table or use a custom property editor by clicking on
the ellipsis button ([=J) on the right side. The custom editor pops up in a new dialog.

The type of the editor depends on the data type of the property. JFormDesigner has built-in property
editors for all standard data types. Custom JavaBeans can provide their own property editors. Take a look
at the API documentation of j ava. beans. PropertyEdi t or, j ava. beans. PropertyDescri pt or and

j ava. beans. Beanl nf o and the JavaBeans topic for details.
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Built-in property editors
JFormDesigner has built-in property editors for following data types:

@ String, bool ean, byte, char, doubl e, fl oat, i nt, | ong, short, java.l ang. Bool ean, java. |l ang. B
yte, java.l ang. Character, java. |l ang. Doubl e, j ava. | ang. Fl oat , j ava. | ang. | nt eger,
java. |l ang. Long, j ava. | ang. Short, j ava. mat h. Bi gDeci mal and j ava. mat h. Bi gl nt eger

# ActionMap (javax.swing)

# Border (javax.swing)

# Color (java.awt)

# ComboBoxModel (javax.swing)
# Cursor (java.awt)

# Dimension (java.awt)

“ Font (java.awt)

# Icon (javax.swing)

# Image (java.awt)

# InputMap (javax.swing)

# Insets (java.awt)

# KeyStroke (javax.swing)

# ListModel (javax.swing)

# Object (java.lang)

# Paint (java.awt)

“ Point (java.awt)

# Rectangle (java.awt)

# SpinnerModel (javax.swing)
# TableModel (javax.swing)

# TreeModel (javax.swing)

ActionMap (javax.swing)

This (read-only) custom editor allows you to see the actions registered for a component in its action map.
The information in the column "Key Stroke" comes from the input map of the component and shows
which key strokes are assigned to actions. The JComponent property "actionMap" is read-only. Select the
Show read-only Properties button in the Properties view toolbar to make it visible.

@ actionMap @

Hey Stroke Action Key + Action
heep javax swing text DefautEditorkitjBeepAction
caret-backward javax swwing text DefaultEditorkitiMextisual...
caret-hedin javax swwing text DefaultEditorkitiBeginiction
caret-begin-line javax swing text DefaulttEditorkitiBeqginLine s, .
caret-hedin-paragraph javax swing text DefaulttEditorkitiBeqginParag. .
caret-hedin-sword javax swwing text DefauttEditorkitiBeginmiord...
caret-dowwn javax swing text DefautEditarkit fMexdisual...
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Border (javax.swing)

You can either select a border from the combo box in the properties table or use the custom editor.

UGLJ\.HI gl A | - .L-\_ll.ll .L-\_l-\_ll FAaRn]
oo )|

foreground [detault)
toolTipText [ho border)
TitledBorder

[TitledBorder, DLUZ_BORDER]
[TitledBorder, EmptyBorder(5,5 5 57
BevelBorder

EmptwBarder’s.5.5.57

Properties | Code Gener

In the custom editor you can edit all border properties. Use the combo box at the top of the dialog to
choose a border type. In the mid area of the dialog you can edit the border properties. This area is
different for each border type. At the bottom, you can see a preview of the border.

Following border types are supported: Bevel Bor der, ConpoundBor der, Dr opShadowBor der ( Swi ngX) ,
Enpt yBor der , Enpt yBor der (JGoodi es), Et chedBor der, LineBor der , Mat t eBor der , Sof t Bevel Bor der,
Ti t| edBor der, Swi ng and custom borders.

Border type: | TitledBorder bl |

Border properties

Title: | Address |
Title justification: | Leacing v |
Title position: | Top bl |
Title color: [ [default) ]
Title fort: | (defaut) | Esit.. |
Eorder: |(defaurtj | [ Edit... ]
Preview
Address

[ K, ] [ Cancel

Color (java.awt)

In the properties table, you can either enter RGB values, color names, system color names or Swing
UIManager color names. When using a RGB value, you can also specify the alpha value by adding a
fourth number.

236 233 216| (]
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The custom editor supports various ways to specify a color. Besides RGB, you can select a color from the
AWT, System or Swing palettes.

i HsB | RGB | MWT Palette | System Palette | Swing Palette

T T O
| T
| _IIIIIIIII IIIIII

Recent:

Preview

1 -

D Sample Text Sample Text

Ik,

| |

Cancel

ComboBoxModel (javax.swing)

This custom editor allows you to specify string values for a combo box.

ComboBox madel tems:

red
greemn
bhlue

-~

b

Each line inthe above text field represents a value in the model.

[ QI ] [ Cancel

Cursor (java.awt)

This editor allows you to choose a predefined cursor.

L AU AT TN I

LIS Y I

DEFALLT

doubleBuffered

enabled CROSEHAIR
focusable TEXT
focusCyeleRoot AT
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Dimension (java.awt)

Either edit the dimension in the property table or use the custom editor.

@ preferredSize @

[ K l [ Cancel ]

Font (java.awt)

You can either use absolute fonts, derived fonts or predefined fonts of the look and feel. Derived fonts are
recommended if you just need a bold/italic or a larger/smaller font (e.g. for titles), because derived fonts
are computed based on the current look and feel. If your application runs on several look and feels (e.g.
several operating systems), derived fonts ensure that the font family stays consistent.

In the properties table, you can quickly change the style (bold and italic) and the size of the font.

Fonk BOld +5

I ]

In the custom editor you can choose one of the tabs to specify either absolute fonts, derived fonts or
predefined fonts.

Font | Derived Font | Swing Font | Derived Fort | Swing
Eamily: Skyle: Size: Family
|'u'er|:|ana | |Eh:u|d Ttalic | | 16|% | Earnily: | (unchanged) w
SHLESL || Plain 11 A
i — Skyl
Syrmbol Bald - ¥le
Tahorna Tralic 14 Bald: (" unchanged (&) set () clear
Tirnes Mew Rornan Binld Thalic
Trebuchet M5 e Tkalic: {unchanged (3 set () clear
Tunga
20 .
Yerdana 23 Size
Wrinda 74 () relative +5
Webdings
— 26
Wingdings W e W () absalute I:I
Werdana 16 Bold Italic Tahoma 16 Bold Italic
Preview Preview
The quick brown fox jumps over The quick brown fox jumps over the
[ QK l [ Cancel ] [ Ok, l [ Cancel ]
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Icon (javax.swing) and Image (java.awt)

This custom editor allows you to choose an icon. Either use an icon from the classpath, from the file
system or from the Swing UIManager (look and feel). It is recommended to use the classpath and embed
your icons into your application JAR.

Image source type:

@ Clazzpath (e.g. fcombfmyappimage .oif]
{:} File system [e.q. cmyappimadge.gif

{:} Sunirig

O Ma icor (ol

() Detault icon

Paime: |J'c:n:nrnffn:-rmdev.fh:nn:-lkitrresaurcesipaste_ed'rt.gif | [ Browese...

Preview

B

Dimenzion: 16 x 16
Size: E0S Byte

[ I ] [ Cancel

InputMap (javax.swing)

This (read-only) custom editor allows you to see the key strokes registered for a component in its input
map. The information in the column "Action"” comes from the action map of the component and shows
which action classes are assigned to key strokes. The JComponent property "inputMap" is read-only.
Select the Show read-only Properties button in the Properties view toolbar to make it visible.

@ inputMap @

| When Focused (29) | YWhen in Focused Window (00| Wwhen &ncestor of Focused Component (0]

Hey Stroke Action Hey * Action

KP_LEFT caret-hackward M
LEFT caret-backward

HOME caret-begin-line

EMD caret-end-line

KP_RIGHT caret-forward

RIGHT caret-faruward w

Close
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Insets (java.awt)

Either edit the insets in the property table or use the custom editor.

@ margin ['5_<|

Tog: 2 % | pixel
Left: 14 % | pixel

Bottorm: 2 % | pixel

Right: 14 % | pixel

[ I l [ Cancel ]

KeyStroke (javax.swing)

In the properties table, you can enter a string representation of the keystroke. E.g. "Ctrl+C" or
"Ctrl+Shift+S".

The custom editor supports two ways to specify a keystroke. Either type any key stroke combination if
the focus is in the first field or use the controls below.

The KeyStroke editor supports menu shortcut modifier key (Command key on Mac OS X, Ctrl key
otherwise).

@ accelerator @

Type any key stroke combinstion:

| Clrl+Shift+S |

Key Stroke Properties
Moditiers: ot [ Ak shift [ meta [ Ak Gr

|:| henu shortout (Meta on Mac O X, Ctrl otherswise)

Hey code: | = b |

[ (] ] [ Cancel ]

ListModel (javax.swing)

This custom editor allows you to specify string values for a list.

Lizt model tems:

red e
Jreen —
hlue

w

Each line inthe above text field represents a value in the model.

Ok ] [ Cancel
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Object (java.lang)

This editor allows you to reference any (non-visual) JavaBean as a property value. Often used for
JLabel . | abel For.

[LELE 1] ]

labelFor -_[— phioneField W
text [none)
toolTipText L cityField
veticalAlignment _]:_ countryField

7 nametField

Properties | Code GEnEr“‘ *]:— ZipField

Paint (java.awt)

This editor allows you to specify a j ava. awt . Pai nt object (used by j ava. awt . Gr aphi cs2D). Use the
combo box at the top of the dialog to choose a paint type. In the mid area of the dialog you can edit the
paint properties. This area is different for each paint type. At the bottom, you can see a preview of the
paint. For GradientPaint you can click-and-drag the handles in the preview area to move the points.

Following paint types are supported: Col or and G adi ent Pai nt .

@ paint E'

Paink type: GradientPaink

Paink properties

Colors;

Point 1 (/v | 12 |8 | | als | pizel
Point 2 (xfyh | 75 | | cxc] - | pizel
angle: 21 % | degree
Magritude: 67 3 | pixel
Cyclic

Preview

(o)1 l [ Cancel
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Point (java.awt)

Either edit the point in the property table or use the custom editor.

@ [ocation b_<|

[

|-

pixel

77 = | pixel

[ K l [ Cancel ]

Rectangle (java.awt)

Either edit the rectangle in the property table or use the custom editor.

@ maximizedBounds @

pixel

pixel

ERGE

=
=

pixel

Height: pixel

I, l [ Cancel ]
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SpinnerModel (javax.swing)

This custom editor allows you to specify a spinner model (used by JSpi nner ). Use the combo box at the
top of the dialog to choose a spinner model type (Number, Date or List). In the mid area of the dialog
you can edit the model properties. This area is different for each model type. At the bottom, you can see
a test spinner where you can test the spinner model.

hdodel type: | Murnkber W |

Model properties

Mumber type: | Integer v|

Initizl walue: | 1] |

[ Minirmur: | |

[ Mairmurn: | |

Stepsize. | 13
Preview

Here you can test the above zettings.

Test spinner: | 1] |

[ I ] [ Cancel ]

String (java.lang)

Either edit the string in the property table or use the custom editor. Switch the "allow new-line" check
box on, if you want enter new lines.

The above table is editable. 3elect a cell and start Cyping.
Uze FETURN to commit, E3C to cancel and arrow keys to mnove
zelection.

|:| allo: nesy-line

Localization

|:| Store string in rezource bundle (properties file)

Ik l [ Cancel ]
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TableModel (javax.swing)

This custom editor allows you to specify values for a table.

Tahle model tems:

First natme Last name male Columns
Jokin Stnith [ o 3
Steve Miller

!

Mowve Left

ol |=
o || m
b -~

Court: 28

5 =]
o || o
m -+

hdovve Lp
The above table iz editable. Select a cell and start typing. Use RETURN to cormmit, ESC
to cancel and arrove keys to move selection.

Column properties

Here you can edit the properties of the calumn selected in the above table.

Mo Tile: | male Pref. wicth: | 30 &
Type: | | Min. wvicith: 30 %

editable [ ] resizable M. wichth 3005

[ 8] l [ Cancel

e

TreeModel (javax.swing)

This custom editor allows you to specify string values for a tree.

Tree model tems: Presviewy:
colors - lcolors
red * red
gJreen - Qreen
hlue .' blL,IE
b

Each line in the above text field represents a node in the madel.
U=ze tabs to indent a line to deeper levels.

Il l [ Cancel
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2.6.2 Layout Properties

Each container component that has a layout manager has layout properties. The list of layout properties
depends on the used layout manager.

Select a container component in the Design or Structure view to see its layout properties in the
Properties view.

E= Properties gy |
Mame Yalue
Mame this
Class JPanel
= Layout FlawLayouk [CEMTER, 5, 5]
alignment ZEMTER.
horizontal gap 5
wertical gap 5
L align on baseline {Java 6)| [ ]false

TR —— A [ [P

This screenshot shows layout properties (alignment, horizontal and vertical gap) of a container that has a
FlowLayout.

When you add a container component to a form, following dialog appears and you can choose the layout
manager for the new container. You can also set the layout properties in this dialog.

@ New JPanel [5_(|

Create a new JPanel

Choose a layout manager and set initial properties,

Layout manager: | FlowL ayouk W

FlowLayout options
Aligrirnent: O left {(#) center () right
) leading () trailing

[] Align on baseline {1ava &)
Horizontal gap: pixel
Wertical gap: I:I pixel

equal gaps

[ (8] 4 l [ Cancel

2.6.3 Constraints Properties

Constraints properties are related to layout managers. Some layout managers (FormLayout, TableLayout,
GridBaglLayout, ...) use constraints to associate layout information to the child components of a
container.

The list of constraints properties depends on the layout manager of the parent component.
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Select a component in the Design or Structure view to see its constraints properties in the Properties

view.

E= Properties o |
Matne Walue

Hame lakel

Class

= Constraints
grid x

| JLabel

grid v

grid wicth

grid heighit

h align

DEFALLT

v align

DEFALLT

= inzets

0,0,0,0

beaelarmn me]

1 a=e 22 e

This screenshot shows constraints properties of a component in a FormLayout.

2.6.4 Client Properties

What is a client property?

Swings base class for all components, j avax. swi ng. JConponent , provides following methods that allows
you to set and get user-defined properties:

public final
public final

hj ect getCientProperty(oject key);
void putCientProperty(Chject key,

Chj ect val ue);

Some Swing components use client properties to change their behavior. E.g. for JLabel you can disable

HTML display with | abel . put d i ent Property("htn . di sabl e",

Bool ean. TRUE) ; You can use client

properties to store any information in components. Visit Finally... Client Properties You Can Use on Ben
Galbraith's Blog for a use case.

Define client properties

You can define client properties on the Client Properties page in the Preferences dialog.

Edit client properties

If you've defined client properties, JFormDesigner shows them in the Properties view, where you can set
the values of the client properties.

E= Properties o W
Matne Salue

Hame bttor

Class JEutton
ElClient Properties

Himl dizakle true

= styleClass smallEutton

action

larlerm el [ 228 222 Me
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2.7 Error Log View

This view appears at the bottom of the main window if an exception is throw by a bean. You can see
which bean causes the problem and the stack trace of the exception. This makes it much easier to solve
problems when using your own (or 3rd party) beans.

’,FJ Errar Log

B4 | B =

Component, Meszage Exception
shlitPanel |Failed to =et propetty "resizelWeight" to "2". |Illegal.&rgumer‘|tEx|:eptinn: JzplitPane we. ..

Toolbar commands

EE] Copy Log Copies all log records to the clipboard.

.+  Clear Log Clears the log.

L Properties Displays the properties of the selected log record in a dialog (see below).
& Close Closes the Error Log view.

Double-click on a log entry to see its details:

@ Error Properties @

Drate: 03.00.2005 16:05:24 {l\”

Component. splitPanet

Meszage: Failed to zet property "resizeyveight” to "2". - @7
:

Exception Stack Trace:

ava lang llegalArgumertException: JSplitPane weight must be betveen 0 and 1 L

at javax.swing JSplitPane setResizeWWeight(JSpitPane java: FO2)

at sun reflect MativeMethod&cceszorlmpl.invokel{Mative Methodd)

at sun reflect MativeMethod&cceszorlmpl.invokelMativeMethod Accessorlmpl java: 39)

at zun.reflect DelegatingMethod Accessotinplinvokel Delegatingtethod Accessarlmpl jay

at java lang.reflect Method invaoke(Method java 324) v

£ >

How to fix errors

This mainly depends on the error. The problem shown in the above screenshots is easy to fix by setting
resi zeWei ght to a value between 0 and 1.

If the problem occurs in your own beans, use the stack trace to locate the problem and fix it in your
bean's source code. After compiling your bean, click the Refresh button in the designer toolbar (or press
F5) to reload your bean.

If you are using 3rd party beans, it is possible that you need to add additional libraries to the classpath.

You should be able to identify such a problem on the kind of exception. In this case, add the needed
libraries to the JFormDesigner classpath of the current Project, and refresh the Design view.
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JFormDesigner provides easy-to-use and powerful localization/internationalization support:

# Externalize and internalize strings.

# Edit resource bundle strings.

® Create new locales.

® Delete locales.

# Switch locale used in Design view.

# In-place-editing strings of current locale.

# Auto-externalize strings.

# Choose existing strings.

# Updates resource keys when renaming components.
“ Copies resource strings when copying components.
# Removes resource strings when deleting components.
# Localization preferences.

# Fully integrated in undo/redo.

The locales combo box in the toolbar allows you to select the locale used in the Design, Structure and
Properties views. If you in-place-edit a localized string in the Design view, you change it in the current
locale. A small globe in front of property values in the Properties view indicates that the string is localized
(stored in a properties file).

a4 JFormbesigner 3.0 - MyProject

Fie Edt Wew Form Window Help

Biz-W [ -5 G < = «rf' 2 @ X O - | windows | &= T _.f:- = Cerman (d.,
==/ | g (defaut) :

83 Paistte & | | E = addreszPanel Ty St —— (d8)

[t SewectionMode | » s 3 - 5 3 phoneLsoe! (Tel ) ”
i.4 Marques Selection| | 4 [ phoneFieid

@ Choose Bean... ?-[;I“Ct'f‘-’ahm PLEZ for

zpFisld

= Cooen rits

e : i 1 edyFiend

a'.l:.l JLabed A |5 X

[ JTesdFisld 7 : E [ courtryFied d
fhet)

JCeenbieBi . —
lj.ELlhun —| Properties o |
B! ICheckBio T ok
% JRedoBution ] M= Zans el 11 ."‘
i foresround W bisck

“JTnggaEI.llnn horizontalAlignm.... | LEADMNG
EH grenares =
¥ a FER

S e tewt SLand )l
L3 Windows tooiT p Text |
C Menus vartical&ignment | CENTER hd
3 JGoodies Progerties | Code Genaration

licensed 10 Karl Tauber
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Create a new localized form

When creating a new form, you can specify that JFormDesigner should put all strings into a resource
bundle (.properties file). In the New Form dialog select the Store strings in resource bundle check
box, specify a resource bundle name and a prefix for generated keys. If Auto-externalize strings is
selected, then JFormDesigner automatically puts all new strings into the properties file (auto-externalize).
E.g. when you add a JLabel to the form and change the "text" and "toolTipText" properties, both strings
will be put into the properties file.

To localize existing forms use Externalize Strings.

Create a new Form

Choose a superclass, button bar and layout manager .

Superclass: @ JPanel {:} JDilog D JFrame {:} other

Content Pane Layout

Layout manager: FarmLayout (JGoodies) hd

FormLayout options

Murnber of columns: 2

4| |4k

Murnber of rowes: 3

inzert gap columns §rowes

F n
Localization

Store strings in resource bunde (properties file) Auto-externalize strings

Fesource bundle name: cotn tmyapp Bunde Browvse ...

Prefix for generated keys: | AddressPanel [Ino prefiz

LS -

I, ] [ Catcel ]
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Edit localization settings and resource bundle strings

To edit localization settings and resource bundle strings, select Form > Localize from the main menu or
click the Localize button in the toolbar. Here you can create or delete locales and edit strings. The light
gray color used to draw the string "Name:" in the table column "German" indicates that the string is
inherited from a parent locale.

® Localize @

Localization settings and resource bundles

Edit localization settings, resource bundle strings or add new locales.

Localization settings

Resource bundle name: com.myspp Bundle Ercuwse...

Rezource bundle file: CobdyProjectisrcicammyapp'Bundle properties

Prefix for generated keys: | AddressPanel Auto-externalize strings

Rezource bundles

Strings:
ey = [detault) ™ cerman [de)
AddressPanel countryLakbel text Cauntry: Land;
AddrezsPanel nameLabel text Marme: %
AddressPanel phonelakbel text Phione:; Tel. -
AddressPanel zipCityLabel text ZIP f City: PLZ xon:;“nahrgfi'te d from locale (default)

The above takle iz editakle. Select a cell and start typing. Use RETURN to commit, EZC to cancel and arrowy keys to move sel.

|:| Shaowy anly strings used in active form

[ e Locale. .. ] [ Delete Locale... Ok ] [ Cancel ] [ Apply

The Resource bundle name field is used to locate the properties files within the Source Folders of the
current Project. Use the Browse button to choose a resource bundle (.properties file).

In the Prefix for generated keys field you can specify a prefix for generated resource bundle keys. The
format for generated keys is "<prefix>.<componentName>.<propertyName>". You can change the
separator ('.") in the Localization preferences.

If the Auto-externalize strings check box is selected, then JFormDesigner automatically puts all new
strings into the properties file. E.g. when you add a JLabel to the form and change the "text" and
"toolTipText" properties, both strings will be put into the properties file. You can exclude properties from
externalization in the Localization preferences.
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To create a new locale, either select Form > New Locale from the main menu, New Locale form the
toobar or click the New Locale button in the Localize dialog. Select a language and an optional country.
You can copy strings from an existing locale into the new locale, but JFormDesigner fully supports
inheritance in the same way as specified by j ava. util . Resour ceBundl e. E.g. if a message is not in

locale "de_AT" then it will be loaded from locale "de".

& New Locale §|

Create new locale

Specity the language and country of the nesw locale.

Locale
Langusge: | P Cerman ide) V|
Courtry (optional): | (hone) b |
|:| Showy all languages and countries
Copy
Copy strings from: | (hone) W |

[ Ik l [ Cancel ]

Delete a locale

To delete an existing locale, either select Form > Delete Locale from the main menu, Delete Locale
form the toobar or click the Delete Locale button in the Localize dialog. Select the locale to delete.

@ Delete Locale @

Delete a locale

Select the locale to delete.

Locale: ™ Cerman (el b

Mote:

# Deleting a locale deletes the properties file of the specified locale.
# |f the propetties file contains strings used in other forms, they are lost.
# Locale deletion can not be undone.

[ QI ] [ Cancel

Externalize strings

Externalizing allows you to move strings from a .jfd file to a .properties file. If you want localize existing

forms, start here.
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Select Form > Externalize Strings from the main menu or Externalize Strings from the toolbar,
specify the resource bundle name, the prefix for generated keys and select/deselect the strings to
externalize. You can exclude properties from externalization in the Localization preferences.

® Externalize 5trings D_q

Externalize Strings to a resource bundle

Move strings to a resource bundle far localization.

Resource bundle natme: | com.myspp Bundle | [ Eroveze. .. ]

Prefix for generated keys: | AddressPanel | [F] ho prefix

Auto-externalize strings on subsequent changes

Externalize strings to locale: [default]

Strings to externalize:

Component Property Walue Hey
-:u:uuntrg.-'LaheI texdt Courtry: AddressPanel countryLabel text
5 nameLabel text Marme: AddreszPanel namelakbel text
phnneLaheI texdt Phione: AddrezsPanel phonelakel text
zipC'rtyLabel texdt ZIP [ City: AddrezsPanel zipCityLabel text
| selectan | [ Deselect 4 o || cencel

You can also externalize and internalize properties in the Properties view.

toolTipTe:xd B Restore Default Yalue
verticalAlianment F Set Yalue to rul

]

bl

# Inkernalize String

M, Mo Java Code

Internalize strings

Internalizing allows you to move strings from a .properties file to a .jfd file.
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Select Form > Internalize Strings from the main menu, specify the locale to internalize from and
select/deselect the strings to internalize. If you internalize all strings, JFormDesigner asks you whether
you want to disable localization for the form.

® Internalize Strings ['5—<|

Internalize Strings to the form

Move strings from a rezource bundle into the form and remove the strings from the resource bundle.

Internalize strings from locale: | [default) W

Strings to internalize:

Component Property Walue Hey
-:u:uuntrg.-'LaheI tet Courtry: AddreszPanel .countryl. ..
250 nameLabel tet Marne: AddreszPanel namelLab. ..
phnneLaheI tet Phone: AddreszPanel phonela. ..
250 zipCityLabel test ZIP f City: AddressPanel zipCityLa...
| seectan || Deselectan | ok || cancel

Choose existing strings

The globe button (E]) in the Properties view, which is only available for localized forms and string
properties, allows you to choose existing strings from the resource bundle of the form.

labelFor |

toolTipText

In the Choose Key dialog you can search for keys and/or values. Then select a key in the table and
press OK to use its value in the form.

@ Choose Key @

Choose a key

Search for kevs or values and select a key.

Search string (7 = any character, * = any String):

hdatching strings:

Hey = P ol
AddressPanel.countryLabel text |Land:
AddrezsPanel.nameLlabel text
AddressPanel phonelabeltext  Tel.
AddressPanel.zipCityLabeltext  PLZ 7 Or:

Search for: (O Hey O Value (0 Both  [] Case sensitive

Showy only keys that start with key prefic of active farm ("AddressPanel ")

[ Pesw String... ] [ Delete String ] [ QI ] [ Cancel
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2.9 Projects

Stand-alone edition only. The IDE plug-ins use the source folders and classpath from the IDE projects.

Projects allow you to store project specific options in project files. You can create new projects or open
existing projects using the menubar or toolbar.

When you start JFormDesigner the first time, it creates and opens a default project named
DefaultProject.jfdproj in the folder ${user.home}/.jformdesigner, where ${user.home} is your home
directory. You can see the value of ${user.home} in the About dialog on the System tab.

You can use the default project, but it is recommended to create an own JFormDesigner project in your
project root folder. Then you can commit the JFormDesigner project file into a version control system and
reuse it on other computers. Paths in the project file are stored relative to the location of the project file.
Project files have the extension .jfdproj

Pages:

# General
# Source Folders
# Classpath

General

When creating a new project, you can specify a project name and the location where to store the project
file.

® Project Properties for MyProject f'5_<|

_W | General |

t-Saurce Folders

i------C|-E'|55|:I-E'||:|‘| Specify the name and location of your project,

Project name: |M§.-'F'r|:-ject |

Locakion: |C:'|,MyF‘ru:ujeu:t

De=scription:

K ] [ Cancel
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Source Folders

On this page, you can specify the locations of your Java source folders. Source folders are the root of
packages containing .java files and are used find resource bundles for localization and are also used by
the Java code generator to generate package statements.

3 Project Properties for MyProject [z|
¢-(aeneral |Suurl:E Folders |
- 0Lrce Folders

E------'C|EISSI:IEI|:|‘| Specify the locations of wour Java source Folders, These are used ko find resource
bundles and to generate Java package statements.

Java source Folders:

[ spc
2 testsrc

[ oK l [ Cancel

If the folders list is focused, you can use the Insert key to add folders or the Delete key to delete
selected folders.

Classpath

To use your custom components (JavaBeans), JFormDesigner needs to know, from where to load the
JavaBean classes. Specify the locations of your custom JavaBeans on this page. You can add JAR files or
folders containing .class files.

@ Project Properties for MyProject [5_<|

General | Classpath |
te-Source Folders

Specify the locations of your custom JavaBeans, These are used ta load JavaBeans
for editing Farms and for the component palette,

Classpath:

[ classes
['j [rljavallibsijide.1.9.2.03, evalilibljide-cormmon, jar
['j Du\javailibstjide.1.9.2.03, eval\lib\jide-components. jar

f'j CnhjavaiMicCalendarifiblmigoalendarbean. jar

) likimybeans, jar

LIt

Moke; "Edit", "Remove" and "Move Upf/Down" have no effect on already opened
fForms, Refresh the designer to take effect.

[ Ok l [ Cancel

If the classpath list is focused, you can use the Insert key to add folders/JAR files, the Delete key to
delete selected folders/JAR files, Ctrl+Up keys to move selected items up or Ctril+Down keys to move
selected items down.
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2.10 Preferences

This dialog is used to set user preferences.
Stand-alone: Select Window > Preferences from the menu to open this dialog.

Eclipse plug-in: The JFormDesigner preferences are fully integrated into the Eclipse preferences
dialog. Select Window > Preferences from the menu to open it and then expand the node
"JFormDesigner" in the tree.

IntelliJ IDEA plug-in: IntelliJ IDEA uses the term "Settings" instead of "Preferences". The
JFormDesigner preferences are fully integrated into the Intelli] IDEA settings dialog. Select File >
Settings from the menu to open it and then click the icon named "JFormDesigner".

JBuilder plug-in: The JFormDesigner preferences are fully integrated into JBuilder preferences dialog.
Select Tools > Preferences from the menu to open it.

Pages

® General
® FormLayout (JGoodies)
“ null Layout
® Localization
® Look and Feels
® Java Code Generator
* Templates
® Layout Managers

Localization

Code Style (Stand-alone only)
® Client Properties

® Native Library Paths

® BeanInfo Search Paths

® Squint Test

Import and export preferences

You can use the Import button to import preferences from a file and the Export button to export
preferences to a file. This preferences file is compatible with all JFormDesigner editions. On export, you
can specify what parts of the preferences you want export.

Eclipse plug-in: You can use the menu commands File > Import and File > Export to import and
export preferences to/from Eclipse preferences files.

Intelli] IDEA plug-in: You can use the menu commands File > Import Settings and File > Export
Settings to import and export settings to/from IntelliJ IDEA preferences files.

JBuilder plug-in: Import and export of preferences is not supported.

Note: Each IDE uses its own file format for preferences. The only way to transfer preferences between
the different JFormDesigner editions is to use JFormDesigner preferences files.

Restore defaults

Use the Restore Defaults button to restore the values of the active page to its defaults.
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General

On this page, you can specify general options.

® Preferences

_m | General

— [

----- FaormLayout {JGoodies)
----- null Layouk Animation
""" Lacalization animate layouk changes in Design view
----- Look and Feels
=-Java Code Generatar animation speed; () fast (&) default () slow
----- Templates
~-Layout Managers | Other
""" Lacalization Buffer Design wview in video memory
LCode Skyle
----- Client Properties Indo histary size: 1.000 3
----- Mative Library Paths
----- BeanInfo Seatch Paths
----- Squint Teskt
Impart. .. ] [ Expart. .. ] [ Reskore Defaulks o4 l [ Cancel
Option Description Default
Animate layout If enabled, changes to the layout in the Design view are done animated. On
changes in Design
view
Animation speed The speed of the animation. default

Buffer Design view in  If enabled, parts of the Design view are buffered in the video memory of the graphics On
video memory card to improve painting speed.

Undo history size The maximum number of steps in the undo history of a form. 1000
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FormLayout (JGoodies)

On this page, you can specify FormLayout related options.

® Preferences

JFormDesigner 4.0.2 Manual

- {GEMEral |FurmLayuut {IGoodies)

— &9

ormLayout {IGoodies)

-l Latyouk
~Localizakion

-Look and Feels
[=-Java Code Generator

Jzoodies Forms version: | 1.2 or later  »

Column/row templates for new columns /rows

Intellizap {auto-insertfremove gap columnsrows)

&-Templak
Sllssses Column: | default default W |
~Layout Managers
;—----L::u:alizatinn Colurin gap: | label component gap adlu (W |
L..Code Skyle
-~ {lignt Properties Row; | defaulk default % |
-Mative Library Paths o | i m v|
-~ BeanInfo Search Paths o gap: Ine 9ap Al
..... Sauint Tesk
R Custom column/row templates
Display Mame =« | Identifier Colurmn Speci,.. | Row Specification| Gap
my line gap mylinegap Fill:2dlu Fill: 2diu
my paragraph gap myparagraphgap Fill:10dio Fill: 10dlu
Layoutrap Initialization Code
Impart. .. ] [ Expart. .. ] [ Restore Defaulks ] [ K l [ Zancel ]
Option Description Default
IntelliGap If enabled, JFormDesigner automatically inserts/removes gap columns/rows. On
JGoodies Forms Required JGoodies Forms version for the created forms. JGoodies Forms 1.0.3 1.2 or later
version and later require Java 1.4 or later. JGoodies Forms 1.0.2 is the last version that
supports Java 1.3.
Column/row templates Here you can specify the column and row templates that should be used when
for new columns/rows new columns or rows are inserted.
Column The column template used for new columns. default
Column gap The column template used for new gap columns. label
component
gap
Row The row template used for new rows. default
Row gap The row template used for new gap rows. line gap

Custom column/row
templates

If the predefined templates does not fit to your needs, you can define your own
here. Since JGoodies Forms 1.2 you can add these custom column/row
templates to the global LayoutMap using the "LayoutMap Initialization Code" link.
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@ Add Custom Column/Row Template

Custom columin/row template

apecify the custom columngrow template information,

Display name: |y line gap
Identifier: mylinegap

Ise For: (" columns () rows (%) both gaps

Default alignment

) left (T center () right () Fl

Size
) default () preferred () minimum

{*) constant 2 % || Diaglogunits

Resize behavior

]

JFormDesigner 4.0.2 Manual

(%) none
) grow
Java code {optional})
Colurnn code:
Fow code;
(04 l [ Zancel

Option Description

Display name The display name is used within JFormDesigner whenever the template is shown in combo
boxes or popup menus.

Identifier The (unique) identifier is stored in form files. Choose a short string. Only letters and digits are
allowed.

Use for Specifies whether the template should be used for columns, rows or both. Also specifies
whether it represents a gap column/row.

Default alignment The default alignment of the components within a column/row. Used if the value of the
component constraint properties "h align" or "v align" are set to DEFAULT.

Size The width of a column or height of a row. You can use default, preferred or minimum
component size. Or a constant size. It is also possible to specify a minimum and a maximum
size. Note that the maximum size does not limit the column/row size if the column/row can
grow (see resize behavior).

Resize behavior The resize weight of the column/row.

Java code Optional Java code used by the Java code generator. Useful if you have factory classes for

ColumnSpecs and RowSpecs. Not available for JGoodies Forms 1.2 and later.
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null Layout

On this page, you can specify null layout related options.

® Preferences

— [

----- General |nu|| Layout
----- FaormLayout {JGoodies)
..... 1l Layok Snap ko grid
----- Localization _ R
----- Look and Feels Grid & step: 5w
[—:I---J.?'-.fa Code Generator rid ¥ step: 5
- Templates
el Hint: Hold down the Shift key in the Design view to disable grid snapping,
=-Layout Managers
----- Localization
LCode Style
----- Client Propetties
----- Mative Library Paths
----- BeanInfo Search Paths
----- Squint Teskt
Impart. .. ] [ Expart. .. ] [ Reskore Defaulks o4 l [ Cancel
Option Description Default
Snap to grid If enabled, snap to the grid specified below when moving or resizing a componentin  On
null layout.
Grid X step The horizontal step size of the grid. 5
Grid Y step The vertical step size of the grid. 5
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Localization

On this page, you can specify localization related options.

® Preferences @

----- General | Localization |
----- FaormLayout {JGoodies)
""" null Layout Renare resource keys when renaming components
..... ' -I' .E'- t: . .
el Copy localized messages when copying components
----- Lock and Feels
O)-Java Cade Generatar Delete localized messages when deleting components
- Templates Delete localized messages when inkernalizing strings
bl Delete messages only if key prefix is equal to Form's key prefix
Localization
LCode Skyle Insert new messages: next ba similar keys (ascending order) W

----- Client Propetties
----- Mative Library Paths
----- BeanInfo Search Paths

Separatar used For generaked keys:

Template For properties Files:

----- Squint Teskt

it A

# Created by JFormDesigner on §{date}

#

v
Exclude properties from externalization:
conkentType {javax, swing, JEditorPane)
nodePropertyMame
Impart, .. ] [ Expart, .. ] [ Restore Defaulks ] [ Ok l [ Cancel

Option Description Default
Rename resource If enabled, auto-rename resource keys when renaming components and the On
keys when renaming  resource key contains the old component name.
components
Copy localized If enabled, duplicate localized strings in all locales when copying components. On
messages when
copying components
Delete localized If enabled, auto-delete localized strings, that were used by the deleted On
messages when components, from all locales.
deleting components
Delete localized If enabled, auto-delete localized strings, that were internalized, from all locales. On

messages when
internalizing strings

Delete messages only If enabled, messages will be auto-deleted only if there key prefix is equal to the On
if key prefix is equal to  key prefix of the form.
form's key prefix

Insert new messages  Specifies where new messages will be inserted into properties files. "next to next to
similar keys" inserts new messages next to other similar keys so that messages  similar
that belong together are automatically at the same location in the properties file. keys
"at the end of the properties file" always appends new messages to the end of (ascending
the properties file. order)
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Option Description Default
Separator used for Separator used when generating a resource key. N
generated keys
Template for Template used when creating new properties files.
properties files
Exclude properties Specify properties that should be excluded from externalization. Useful when
from externalization using auto-externalization to ensure that some string property values stay in the
Java code.

If the list is focused, you can use the Insert key to add a property or the Delete
key to delete selected properties.

Look and Feels
On this page, you can add Swing look and feels for use in the Design view.

Note: Because Swing is not designed to use two look and feels at the same time (application and Design
view), it can not guaranteed that each look and feel works without problems.

@ Preferences D_d
----- General |Luuk and Feels |
----- ForrnLayout {JGoodies)

..... null Layaout Look and Feels:

""" Localization CDEMatiF {caom . sun. java.swing, plaf motif, MotifLookandFeel)
ook and Feels JGoodies Plastic {com. jgoodies looks. plastic, PlasticLookandFesl)

=-Java Code Generator Jaoodies Flaskic 30 {com, jgoodies Jooks, plastic, Plastic30LookandFeel)

""" Templates JGoodies Plastic XP {com, jgoodies looks, plastic, PlasticiPLookandFeel)
-Layout Managers Jzoodies Windows (com, jgoodies. looks, windows WindowsLookandFeel)
- Localization Metal (javas. swing.plaf metal MetalLookandFeel)
=-Zode Skyle Windows {com,sun.java, swing, plaf . windows  windowsLookandFes)

""" Client Properties Windows Classic {com.sun. java, swing. plaf windows WindowsClassicLookandFeel)

----- Mative Library Paths
----- BeanInfo Seatch Paths
----- Squint Teskt

Impart. .. ][ Expart. .. [ Ik H Cancel
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If the look and feels list is focused, you can use the Insert key to add a look and feel or the Delete key
to delete selected look and feels.

@ Add Look and Feel X

Look and Feel Information

Specify the Look and Feel J&R. archive, name and class name.

Jar path: |C:'I,M'g.fF‘rnject'l,IiI:u'l,lcu_lnststDFF.jar | [ Browse, ., ]
Mame: |KunststDFF |
Class name: |u:u:um.in-:u:urs.pIaF.kunststu:uFF.KunststDFFLanﬁ.ndFeel |

O H Cancel ]

Option Description

Jar path Full path name of the jar file that contains the look and feel classes. Use the Browse button to
select a jar.

Name Name of the look and feel used in the look and feel combo box in the Main Toolbar.

Class name Class name of the look and feel class (derived from j avax. swi ng. LookAndFeel ).

License code License code for the commercial Alloy Look and Feel.
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Java Code Generator

On this page, you can turn off the Java code generator and specify other code generation options.

® Preferences @

----- General |]ava Code Generator |
----- FaormLayout {JGoodies)
----- null Layout: Generate Java source code
----- Localization
----- Look and Feels Options
= 1:a Code Generakor
Source compatibility use JRE version) W
~-Templates . F i I: :I
----- Layaout Managers |:| Explicit imports
. I&D';al'zﬁ‘it"ljn Container blocks [ ] Eclipse non-nls tags {ff$MOM-RLS-nd)
- ode vie .
_____ Client Properties Comments [ ] MetBeans no-il8n tags (fINOI1EM)

----- Mative Library Paths
----- BeanInfo Seatch Paths

[] 5et component names [ | Use 'this' For member variables

Member variables prefix;

----- Squint Teskt
Modifiers
Class modifiers: public
Mested class modifiers: private
Moke: These modifiers are used only when generating new classes,
To change the component variable modifiers and the event handler method
madifiers, seleck "(Farm)" in the Struckure view and activate the "Code
Generation” tab in the Properties wview, There you can set these modifiers for the
active Form,
Impart, .. ] [ Expart, .. ] [ Restore Defaulks Ok l [ Cancel
Option Description Default
Generate Java source If enabled, JFormDesigner generates Java source code when you save a On

code

Source compatibility

Explicit imports
Container blocks
Comments

Set component

names

Eclipse non-nls tags
(//$NON-NLS-n$)

form.

Specifies the compatibility of the generated source code. Besides generating Stand-alone:

Java 1.x compatible source code, JFormDesigner can also use Java 5 (or use JRE

later) features in the generated source code (e.g. auto-boxing, @Override, version

etc). IDE
plug-ins:
use project
setting

If enabled, the code generator adds explicit import statements (without *) for Off
used classes.

If enabled, the code generator puts the initialization code for each container On
into a block (enclosed in curly braces).

If enabled, the code generator puts a comment line above the initialization On
code for each component.

If enabled, the code generator inserts j ava. awt . Conponent . set Nane() Off
statements for all components of the form.

If enabled, the code generator appends non-nls comments to lines containing  Off
strings. These comments are used by the Eclipse IDE to denote strings that
should not be externalized.
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Option Description Default
NetBeans no-i18n If enabled, the code generator appends non-nls comments to lines containing  Off
tags (//NOI18N) strings. These comments are used by the NetBeans IDE to denote strings that

should not be externalized.

Use 'this' for member  If enabled, the code generator inserts 'this." before all member variables. E.g. Off

variables t hi s. naneLabel . set Text (" Nane: ") ;

Member variables Prefix used for component member variables. E.g. "m_"

prefix

Class modifiers Class modifiers used when generating a new class. Allowed modifiers: public
public, defaul t,abstract andfinal.

Nested class Class modifiers used when generating a new nested class. Allowed modifiers: pri vate

modifiers public,defaul t,protected,private,abstract,final andstati c.

You can set additional options per form in the "(form)" properties.

Templates (Java Code Generator)

This page contains templates that are used by the code generator when generating a new class. See
Code Templates for details about templates.

@ Preferences ['5_(|
----- General | Templates |
----- FaormLayout {JGoodies)

----- null Layouk Code termplates:
----- Localization Hew
""" Look and Feels Component 1180 Inikialization
E'"'J'?""'a Code Gerneratar Component Initialization 3
emplates Empy Class
-Layout Managers Event Handler Body b
& Localization -
“-Code Style Selected template: Insert Yariable -
""" C||Er|t Pr_Dpertles fi{modifiers}class ${class name} 7{extends declaration} {
----- Mative Library Paths o
f{constructor modifiers}i{class name} () {
----- BeanInfo Seatch Paths . - ] -
initComponents () ;
----- Squint Teskt }
${component _injitialization}
${wvariables declaration}
}
Impart. .. ] [ Expart. .. ] [ Restore Defaulks Ik l [ Cancel
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New: Create a new template for a specific superclass.

Edit: Edit the superclass of the selected user-defined template.

Remove: Remove the selected template. Only allowed for user-defined templates.

Reset: Reset the selected predefined template to the default.

Insert Variable: Insert a variable at the current cursor location into the selected template.

@ New Template E|
Superclass name: |cu:um.mypruject.My.ﬁ.bstractDiaIDg | [ Browse, .. ]
Copy From: | Class vl

Here you can create a new template for a specific superclass, It will be used to
generate new classes that are derived from the specified superdlass or From
subclasses of the specified superclass,

[ Ok l [ Cancel

Layout Managers (Java Code Generator)

On this page, you can specify code generation options for some layout managers.

® preferences E|
----- General |La1,ruut Managers |
----- FormLayout {JGoodies)
----- ndll Layout FormLayout {JGoodies)
----- Localization

[] Use PanelBuilder in generated cade
----- Look and Feels

=l-Java Code Generator
- Templates
o oot Managers

GridBagLayout
|:| Ise empty GridBagConstraints conskrockar

Localization GroupLayout
“Code Skyle

----- Client Properties

----- Mative Library Paths
----- BeanInfo Search Paths

Generation Style: | (use source compatibility) w |

Tablelayout

""" Jquint Test Package: | info. clearthought.ayout |
Impart, .. ] [ Expart, .. ] [ Restore Defaulks ] Ok l [ Cancel ]
Option Description Default
Use PanelBuilder in If enabled, the PanelBuilder class of JGoodies Forms is used for Off
generated code FormLayout.
Use empty If enabled, the empty GridBagConstraints constructor is used in the  Off
GridBagConstraints generated code, which is necessary for Java 1.0 and 1.1
constructor compatibility. Since Java 1.2, GridBagConstraints has a constructor
with parameters, which is used by default.
GroupLayout Specifies whether class javax.swing.GroupLayout is used, which is use source
Generation Style part of Java 6 and later. Or whether org.jdesktop.layout.GroupLayout compatibility
from the Open Source Swing Layout library swing-layout.jar is used, (see Java Code
which is also available for Java 1.4 and 5. Generator preferences
page)
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Option Description Default

TableLayout package Package name used by the Java code generator for TableLayout. info.clearthought.layout
Change this only if you have a copy of the original TableLayout in
another package.

Localization (Java Code Generator)

On this page, you can specify code generation options for localization.

@ preferences

— [

----- General | Localization
----- FormLayout {JGoodies)

..... null Layaout Initialization
----- Localization

[ ] Generate initComponentsIiEnd) method
----- Loak and Feels

—J--lava Code Generator
t-Templates
t-Layout Managers

Code templates to access resource bundles

‘getBundle’ template: |ResourceBundle,getBundlel${bundietame})

acalization
LCode Shyle
----- Client Properties

_____ Mative Library Paths To change the templates for a specific Form only, select “(Form)" in the Struckure
wigw and activate the "“Code Generation” tab in the Properties wiew, There you can
set these templates For the active Form.

'getString' template: | ${bundle}. getString{$key})

----- BeanInfo Search Paths

----- Squink Tesk
Import, .. ] [ Export. .. ] [ Restore Defaulks oK ] [ Cancel
Option Description Default
Generate If enabled, the code generator puts the code to initialize the Off
initComponentsi18n() localized texts into a method initComponentsi18n(). You can
method invoke this method from your code to switch the locale of a form
at runtime. You can set this options also per form in the "(form)"
properties.
‘getBundle' template Template used by code generator for getting a resource bundle.  ResourceBundle.getBundle
(${bundleName})
‘getString’ template Template used by code generator for getting a string from a ${bundle}.getString(${key})

resource bundle.
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Code Style (Java Code Generator)
Stand-alone: On this page, you can specify code style options, which are used for code generation.

IDE plug-ins: This page is not available in IDE plug-ins because IDEs already have preferences that
control code style. JFormDesigner uses the code style settings from IDE projects or preferences.

® preferences @

----- General |Cude Style |
----- FormLayouk {1Goodies)
----- null Layout Indentation
""" anilizagnn | Indent size: q %
----- Loak. and Feels
=-Java Code Generator Tab size:
Le-Templates
i v| Use tab character
----- Layout Managers a
----- u:u:allzatlu:un other
e Stvle
..... Client Properties Line separakor; | Platform Default W | (applies to new files onky)
..... Mative Library Paths Encoding: | Platform Default w | {platform defaulk is "windows-1252")
----- BeanInfo Search Paths
----- Squint Tesk
Impart. .. ] [ Excpart. .. ] [ Restore Defaulks Ik l [ Cancel
Option Description Default
Indent size The number of spaces used for one indentation level. 4
Tab size The number of spaces that represents one tabulation. 4
Use tab character Specifies whether the tab character (\t) is used for indentation or only space On
characters.
Line separator The line separator used for newly created .java and .properies files. Platform
default
Encoding The character encoding used for reading and writing Java files. Platform
default

-66 -



JFormDesigner 4.0.2 Manual

Client Properties

On this page, you can can define client properties, which can be set in the Properties view.

@ Preferences [5_<|
----- Gaeneral |Elienl: Properties |
----- FaormLayout {JGoodies)
----- null Layouk Define client properties that you can set in the Properties view, See
..... Lacalizakion JComponent. putClientProperty() For details about client propetties.

----- Look and Feels

Client Figs:
=-Java Code Generator | = P CPo e

.. Templates key - Yalue Type Component Class

. Layout Managers hideAckionTezxt java.lang.Boolean javeax, swing. AbstractBut..
..... Lacalization hitrl. disable java.lang.Boolean

Code Style

_lient Propetties
----- Mative Library Paths
----- BeanInfo Search Paths
----- Squint Teskt

Import. .. ][ Export... I O ][ Cancel

If the client properties list is focused, you can use the Insert key to add a client property or the Delete
key to delete selected client properties.

@ Add Client Property f'5_<|

Client property name and type

Specify a Womponent client property,

ke |hide.ﬁ.ctil:unText |

Component class: |javax.swing..ﬁ.bstractﬁutmn |[ Browse, ., ]

If component class is nok sek, the client property is shown For all components,

Walue bype: | java.lang.Boolean W |

{one value per ling;
only if value type is
java.lang. Skring)

Property editor class: |[ Browse. .. ]

Ok ] [ Cancel ]

Option Description

Key The key that identifies the client property.
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Value type

Predefined values

Property editor class
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Description

The component class to which the client property belongs. E.g. if set to javax.swing.JButton,
then the client property is shown in the Properties view for buttons and for subclasses of
JButton. If not specified, the client property is shown for all components.

The type of the client property value. You can select one of the common types (String,
Boolean, Integer, etc) from the combo box or enter the class name of a custom type.

If the value type is java.lang.String, then you can specify predefined values for the client
property. When editing the client property in the Properties view, a combo box that contains
these values is shown. The combo box is editable by default. Select the "Allow only predefined
values" check box to make the combo box not-editable.

Optional class name of a property editor that should be used when editing the client property
in the Properties view.

Native Library Paths

On this page, you can specify the locations of custom JavaBeans that use native libraries and you can
specify the folders where to search for the native libraries.

Note: When removing or changing paths, a restart of JFormDesigner (or the IDE) is probably necessary
to make the changes work.

@ preferences

----- Loak and Feels

Lo-Templates

t-Localization
LCode Shyle
----- Client Properties

----- zeneral |Hative Library Paths |
----- FormLayout {JGoodies)

----- nll Layouk Specify the locations of wour custom JavaBeans, which use native libraries, and

----- Localization specify the locations of ywour native libraries,

—--Java Cade Generator

~Layouk Managers

S:ative Library Paths
----- BeanInfo Search Paths

3

Classpath for JavaBeans, which uses native libraries;
() C\MyProjectiiblgluegen-rt. jar
1 CMyProjecttfibijogl. jar

Makive Library Path:
= C:MyProjectilib

----- Squink Tesk
Impart, .. ] [ Expart. .. [ Ik ] [ Cancel
Option Description

Classpath for
JavaBeans, which use
native libraries

Native Library Path

JAR files or folders containing .class files, which are using native libraries. They must be
specified here to ensure that the native libraries are loaded from a special class loader only
once.

Folders used to search for native libraries.
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BeanInfo Search Paths

On this page, you can
editors.

@ preferences

specify package names that will be used for finding BeanInfo classes and property

%]

----- Loak and Feels
i Templates

- Lacalization
“eCode Skyle

----- Client Properties

----- Mative Library Paths

""" Gzeneral |Beanlnfu Search Paths |
----- FormLayout {JGoodies)

----- rull Lasauk Specify package names that will be used For finding BeanInfo classes and property

..... Lacalizakion editors, See Inkrospector. setBeanlnfosearchPathl) and

=-Java Code Generabor EeanInfo search path:

t-Layout Managers

ieanInfo Search Paths

PropertyEdikorManager  setEditorSearchPath) for details,

com.myapp.beaninfos
com.myapp.misc.beaninfos

Property editar search path:

com.myapp.editors
Com.myapp.misc. editors

----- Squink Tesk
Impart. .. ] [ Expart. .. Ik ] [ Cancel
Option Description

BeanlInfo search path

Property editor search
path

Package names that will be used for finding BeanlInfo classes. Only necessary if the BeaniInfo
class is not in the same package as the component class to which it belongs. See
java.beans.Introspector and Introspector.setBeaninfoSearchPath() for details.

Package names that will be used for finding property editors. Only necessary if the property
editor is not in the same package as the property type to which it belongs. See
java.beans.PropertyEditorManager and PropertyEditorManager.setEditorSearchPath() for
details.
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Squint Test
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The page allows you to specify the squint level for the squint test (menu View > Squint Test).

® Preferences

3

----- General

----- FaormLayout {JGoodies)

----- null Layouk

----- Localization

----- Lock and Feels

[=)--Java Code Generator
- Templates
----- Layout Managers
-Localization
LCode Shyle

----- Client Propetties

----- Mative Library Paths

----- BeanInfo Search Paths

Squink Tesk

|5quinl: Test

L

Lewvel:

Preview:

et bigpresseiont

L e

[ SR LU
e
i

[

Irnport. .. ][ Export,

. ] [ Restore Defaults

e

Rl @il W

Ik ] [ Cancel
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3 IDE Integrations

JFormDesigner is available as stand-alone application and as plug-ins for various IDEs. The IDE plug-ins
completely integrate JFormDesigner into the IDEs.

Following IDE plug-ins are available:

Eclipse plug-in
“ Intelli]J IDEA plug-in
® JBuilder plug-in

Other IDEs

If there is no JFormDesigner plug-in for your favorite IDE, you can use the stand-alone edition of
JFormDesigner side by side with your IDE.

IDE plug-ins for NetBeans and JDeveloper are already under development.

IDE interworking with stand-alone edition
Care must be taken because you edit the Java source in the IDE and JFormDesigner stand-alone also

modifies the Java source file when generating code for the form. As long as you follow the following rule,
you will never have a problem:

Save the Java file in the IDE before saving the form in JFormDesigner stand-alone.
Your IDE will recognize that the Java file was modified outside of the IDE and will reload it. Some IDEs

ask the user before reloading files, other IDEs silently reload files.

If you have not saved the Java file in the IDE, then you should prevent the IDE from reloading it. In this
case save the Java file in the IDE and then use Generate Java Code in JFormDesigner stand-alone.

JFormDesigner generates Java code when you either Save the form or select Generate Java Code.

JFormDesigner does not hold a copy of the Java source in memory. Every time JFormDesigner generates
Java code, it first reads the Java source file, parses it, updates it and writes it back to the disk.
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3.1 Eclipse plug-in

This plug-in integrates JFormDesigner into Eclipse and other Eclipse based IDEs (e.g. JBuilder 2007).

Benefits
Using this plug-in has following benefits compared to JFormDesigner stand-alone edition:

® Fully integrated as editor for JFormDesigner .jfd files. Create and design forms within Eclipse. No
need to switch between applications.

# Uses the source folders and classpath of the current Eclipse project. No need to specify them
twice.

® The Java code generator updates the .java file in-memory on each change in the designer. You can
design forms and edit its source code without the need to save them (as necessary when using
JFormDesigner stand-alone edition).

# Folding of generated GUI code in Java editor.

# Go to event handler method in Java editor. Double-click on the event in the Structure view to go to
the event handler method in the Java editor of Eclipse.

# Two-way synchronization of localized strings in designer and in properties file editors. Changing
localized strings in the designer immediately updates the .properties file in-memory and changing
the .properties file updates the designer.

#® Copy needed libraries (JGoodies Forms, TableLayout, etc) to the project and add them to the
classpath of the current Eclipse project. Optionally include source code and javadoc.

# Integrated with Eclipse's Version Control Systems.

# Integrated into refactoring: Copy, rename, move or delete .jfd files when coping, renaming,
moving or deleting .java files.

User interface

The screenshot below shows the Eclipse main window editing a JFormDesigner form. JFormDesigner adds
the menu Form to the main menu, which is only visible if a JFormDesigner form editor is active.

& Java - FormsTutorial. jfd - Eclipse SDK
file Edt NWavigate Search Project Run Form  Window Help

N-HBEiB-0-Q-  BHF- i G- ®- 5§ save

8 *FormsTutorial jfd [J] FormsTutarial.java = B |8 outine 52 il

o) ] < W | I - | Windows = - & - _JJ SE=RE . S
[ selection Mode 1 . 3 5 ] 7 T (Farm) P
t =-{ @ this [FormLayout]
L.e Marquee Selection | 4| General 4— goodiesFormsSeparato
@ Choose Bean... 3 EE‘E‘EE =il ¢ Company”)
(= Companents [ teutFisdl
A = |5 Contact . %3 labelz ("Contact’ o
: € ]
[ ITextFeld 7 Propeller
[ IComboBax o| | PTI[kW] Sower [KW] I Properties © i
I—1 JButk I . = =
: il " R [mm] D [mm] -

- ! | !

e d Hame Yalue
("3 Containers Hame labed1 |
{*3 Windows Class JLabel
Ca ™ ¥ Constraints | 1,3,1,1,0..

o background ] 236, 233, 2]
Ca JGoodies disolavedn...| b
(71 JFormDesigrer Properties | Code Generakion
Froblems | Javadoc | Declaration | 9] JFormDesigner Error Lag 52 e 0

-
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A JFormDesigner editor consists of:

# Toolbar: Located at top of the editor area.
Palette: Located at the left side.
Design View: Located at the center.

Structure View: Located in Eclipse's Outline view.

Properties View: Located in Eclipse's Properties view.

JFormDesigner 4.0.2 Manual

Error Log View: Automatically opens on errors in a view at the bottom. This view is minimized in
the above screenshot.

Creating new forms

You can create new forms in Eclipse's Package Explorer view. First select the destination package or
folder, then invoke Eclipse's New command and select Other, which opens Eclipse's New dialog. Then
choose JFormDesigner Form from the list of wizards and click Next to proceed.

& New

Select a wizard

Create a JFormDesigner Form

Wizards:

- BX

s LA

|I:3-'|:|e filker bext

@ Class
ﬁ Interface
@ Jawa Project

%’ JFarmDesigner Farm
‘:{[ﬁ Plug-in Project

& Java Praoject from Existing Ant Buildfile

(>

W

@

Cancel

If JFormDesigner Form is in the New sub menu, you can choose it directly without the need to open

Eclipse's New dialog.

i Package Explorer

@ E||%|v =8

[= T== MyProject
= src
=-H

Address

@ FormsTy

@ JavaGer

D) Tabbedr

[ address

Go Inko

Cpen in Mew Window
Open Type Hierarchy F4

Bundle_| =) Copy Ctrl+iC
Bundle_ E2 Copy Qualified Mame
Bundle.f = paste Chri+
E FormsTy I |
M lavacer # Delete Delete
B Playgrol gy path v
[ Tabbedl g5y Alb+Shift+5 >
B e . AlE+SHFE+T ¥
B IRE Swstem Libr
- P S
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In the New JFormDesigner Form dialog, enter the form name (which is also used as class name),

choose a superclass, a layout manager and set localization options.

& New JFormDesigner Form

JFormDesigner Form

Create a new JFormDesigner Farm

E3

Source folder: |M~;.fF'ru:ujeu:t,l'sr|: | [ Browse. .. ]
Package: | COmL My app |
Mame: | |

Superclass: |javax.swing.JF‘aneI |[ Browse, .., ]

{(#) Panel () Ioialog () IFrame () other

[ ] store strings in resource bundle {properties File)

Layaouk manager: |Fn:|rmLa':.n:|ut ([Jzoodies) A |

4

Mumber of columns: 2

4]
r

Mumber of rows;

insert gap columns [ rows

®

Cancel

After clicking OK, the form will be created and opened.

Open forms for editing

You can open existing forms the same way as opening any other file in Eclipse. Locate it in Eclipse's

Package Explorer view and double-click it.

Go to Java code

JFormDesigner adds a button to its toolbar that enables you to switch quickly from a JFormDesigner form
editor to its Java editor.

I
*k Y O-|w
'
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Code folding

To move the generated code out of the way, JFormDesigner folds it in the Java editor.

[ FormsTutorial jfd MO FormsTutorial.java X =08
i
public class FormsTutorial extends JPanel {

[

= public FormsTutoriali) |
initComponents () ;

= private void initComponents(l
& S JFormbesigner — Component initialization - DO NOT MODIFY

@ J¢ JFormbesigner - Variables declaration - DO WNOT MODIFY //GEN-

[ |

Convert NetBeans, IntelliJ IDEA and Abeille forms

You can convert existing NetBeans, IntelliJ IDEA and Abeille forms to JFormDesigner forms. Right-click on
the form file and select Convert to JFormDesigner Form.

[ JavaGeneralprefspl B 1MOOME ; I |

n _ Convert to JFormDesigner Form
[ e N e Export.. 5 E
ey & Refrash 5

[ Tabbedbialog.ifd | ?‘ ) Caonvert 1 Form to JFFormDesigner fiorm?

[ UIFLitePanel i d 8 Convert o JFoemDesignes Form, ..
+ B JRE Syskem Library [jrel .5 fun As

[#] Generate Java code

b
- (3 Forms~1.0.7 jar Debug As ’ [Delete od Form Files
vk Team J [#] Open converked Forms
Compare With ;
Replace Wikth »
Iy | Ho
Properties fk4+Enber ; l ]

When converting an Intelli] IDEA form, JFormDesigner inserts its own generated GUI code into the
existing Java class and removes IntelliJ IDEA's GUI code.

Preferences

The JFormDesigner preferences are fully integrated into the Eclipse preferences dialog. Select Window >
Preferences from the menu to open it and then expand the node "JFormDesigner" in the tree. See
Preferences for details.
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3.2 IntelliJ IDEA plug-in

This

plug-in integrates JFormDesigner into Jetbrains Intelli]J IDEA.

Benefits

Using this plug-in has following benefits compared to JFormDesigner stand-alone edition:

® Fully integrated as editor for JFormDesigner .jfd files. Create and design forms within Intelli]J IDEA.

No need to switch between applications.

# Uses the source folders and classpath of the current IntelliJ IDEA project/module. No need to

specify them twice.

® The Java code generator updates the .java file in-memory on each change in the designer. You can

design forms and edit its source code without the need to save them (as necessary when using
JFormDesigner stand-alone edition).

# Folding of generated GUI code in Java editor.
# Go to event handler method in Java editor. Double-click on the event in the Structure view to go to

the event handler method in the Java editor of Intelli] IDEA.

# Two-way synchronization of localized strings in designer and in properties file editors. Changing

localized strings in the designer immediately updates the .properties file in-memory and changing
the .properties file updates the designer.

#® Copy needed libraries (JGoodies Forms, TableLayout, etc) to the project and add them to the
classpath of the current IntelliJ IDEA project/module. Optionally include source code and javadoc.

# Assign shortcut keys to most JFormDesigner commands in IntelliJ IDEA's keymap settings.
# Integrated with IntelliJ IDEA's Version Control Systems.

User interface

The screenshot below shows the IntelliJ IDEA main window editing a JFormDesigner form.

EI MyProject.ipr - [C:\MyProject-IntelliJ-IDEA] - [MyProject] - ...\src\comimyapp\FormsTutorial. jfd - 1... [= |[B][X]

& 1 project | i

Jﬁ_ 71 Struscture |

File Edt Search WYiew GoTo Code Analvze Refackor Build Run Tooks  Version Control  Window  Help
B sG iR2R oA 8a 8-re ||t d

[l FormeTutorisl, jfd [ D FormTitorial java | 50 bo Java code 'FormsTuborial, java |:C|:II+S|1FI:+D}|
& % |0 [x][Moy eaTheme [-]m= = & @[] B ]
[y Selection Made + 1 # 3 - & w7 T tFarm) =]
L E = [ this [FormLay
1.4 Margues Selection 1 General i |
@ Choose Bean 3 Eomnanys | | fioy Bodestormesepar atord
UL L labell {"Compary™) |
L= Components s Cantact [ | _ re:ctFlelu:Il.m _
iy dLabel lz i label2 - ack
. | bextField2
[ MextField 7 Propeler ¥
T i esFormsSeparabor] (T
Coxmtane [0 PO ] b [ | e
=3 Button 11 R i} . 4L mm
ol [ 7] opm [ ] t te W
| MCheckBox
7 Mame Yalue
& RadoButton [ Mame label1 (=]
23 Containers Class ILabel
Windows | Constrainks 1,3, 1, 1, DEF... =
L background L 236, 233, 216
3 Menus displayedine. .,
3 JGoodies displayedMne.., | -1
3 JFormDwesigres Froperties | Code Generation |

[ @ s Topo || 2 Commander || # AntBuld || Q meral
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A JFormDesigner editor consists of:

# Toolbar: Located at top of the editor area.

“ Palette: Located at the left side.

“ Design View: Located at the center.

# Structure View: Located at the upper right. You can hide this view in the editor and show it instead
in IntelliJ IDEA's Structure tool window by unselecting Show Structure in Editor (?3).

“ Properties View: Located at the lower right.

® Error Log View: Automatically opens on errors in a tool window at the bottom. This view is not
visible in the above screenshot.

Creating new forms

You can create new forms in any of IntelliJ IDEA's project views. First select the destination package or
folder, then invoke IDEA's New command and choose JFormDesigner Form.

File Edit Search Mew GoTo Code #nalyge  Refactor Build  Run Tools  Wersion Control

|bﬂ%llh$

Project - com.myapp

EH-%&@@%%HH
Wigw g5 Packages |3|
= MyPraject

(1) Interface

l iﬂ 7t Structure | [ L= F’rnje:t]

— E A Crl+x | L
e olll Ry I Copy criac | © Enum
— @©%  CopyPath Ctrishiftec | (@ @nterface
— B CopyReference Chrtalshiferc | B File
— [ Pl Paste Chripy | 2 Package
— I@ i Bz, ChrShifE4-y E JFarmbesignet Form
— @7 Paste Simple Chrl+alt+shift+y | B Enumeration Class
— Bv Jump to Source Fa | [ Singleton
B [l Librarf oy 5 e b Fbernal Felber Al iFd Felit File Tamnlakac
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In the New JFormDesigner Form dialog, enter the form name (which is also used as class name),
choose a superclass, a layout manager and set localization options.

Mew JFormDesigner. Form @

Create a new Form
Choose a superclass, butkon bar and layout manager,

MName: | |
Superclass: (® JPanel () IDialog () JFrame () ather

| javane swing. JPanel [«]l | Browse.. |
Button bar: (@ 0K | Cancel ()oK (Cnone [ Help

Zonkenk Pane Layaouk

Layout manager; | FormLayout {JGoodies) |E||

FormLayouk options

Mumber of calumns:
Mumber of rows:

[+#] insert gap columns | rows

Localization

[] store strings in resource bundle {properties File) Auto-externalize strings

Resource bundle name: |cc'm.m':.fapp.E=undIe | | Browse, .. |
Prefix for generated keys: | | no prefi
| (a4 | | Zancel ]

After clicking OK, the form will be created and opened.

Open forms for editing

You can open existing forms the same way as opening any other file in IntelliJ IDEA. Locate it in any of
IDEA's project views and double-click it.

Go to Java code / go to form

JFormDesigner adds a button to IntelliJ IDEA's main toolbar that enables you to switch quickly from a
JFormDesigner form editor to its Java editor and vice versa. If a form editor is active, then the button is

named Go to Java code (@). If a Java editor is active, then it is named Go to JFormDesigner form (
=), You can also use Ctrl+Shift+D.

n Tools Wersion Control  Window  Help

Y S

@0 ko Java code 'FormsTutorial java’ (Chrl+-Shift+0) |

un  Toals  Version Contral  Window  Help

» & [E4 | @

| Go ko JFarmbDesigner Form 'FormsTutarial jfd' {Chrl+Shift+0) |
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Code folding

To move the generated code out of the way, JFormDesigner folds it in the Java editor.

[ FormsTukorial jfd l (B)  FormsTutorial java
| =

public class FormsTutorial extemds JPanel [
= public FormsTutoriali()] §
initComponents() ;

] '
ETJ private woid initComponents() {
] '

Convert IntelliJ IDEA, NetBeans and Abeille forms

You can convert existing IntelliJ IDEA, NetBeans and Abeille forms to JFormDesigner forms. Right-click on
the form file and select Convert to JFormDesigner Form.

L 5 Showe Thumbniails Chr-Shitt+T
- E Q:':’:’g;':;ﬁmel Add Componart: to Paletts. .. EIl Convert to JFormDesigner Form [X]
=i OptiorsPanel.form| 2 Maove to Changeiist Convert 1 farm to IFormDesigner form?

4 [l Librasies Refarmat Cade... Chrl+AR+L
Optimize Imports. .. ChrH-AI+O ¥ lgenerate Java code
[esll Corvert to JFormDesigrer Form. ., [] Pelete old Form files
Delete... h Delete [ Open corwerted Forms
Make Madules MyProject’
ficko M yProjec B | ves || Mo |
Compil bl 2

When converting an IntelliJ IDEA form, JFormDesigner inserts its own generated GUI code into the
existing Java class and removes IntelliJ IDEA's GUI code.

Settings

JFormDesigner uses the term "Preferences" instead of IntelliJ IDEA's "Settings". The JFormDesigner
preferences are fully integrated into the IntelliJ IDEA settings dialog. Select File > Settings from the
menu to open it and then click the icon named "JFormDesigner". See Preferences for details.
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You can assign shortcut keys to most JFormDesigner commands in IntelliJ IDEA's keymap settings dialog.
Select File > Settings > Keymap to open it. In the actions tree expand All Actions > Plug-ins >

JFormDesigner.

Keymap
Keymap | Cuick lists

]

kKeymaps | Defaulk

El IQIID':.-'] |Beset | |Del_ete|

k][4

&

3 F F

=
=3 ) Flug-ins

H—} J_j JFormDesigner
— E Converk to JFormDesigner Form, ..

— 3 Test Form
o=k l50 to JFormbesigner form | Java code

E

Action Descripkion:

[] Disable mremanics in menu

— T Sguink Teskt Shortcuks:
— = Show read-anly Properties | &dd Keyboard Shartout, . |
— Hide Event:
L3 R | &dd Mouse Sharkout,. |
— @, Internalize Strings. ..
— 5o Show Advanced Properties = | Remove |
|| (04 I I Zancel ] | apply | I Help ]
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3.3 JBuilder plug-in

This plug-in integrates JFormDesigner into JBuilder 2005 and 2006. For JBuilder 2007 use the Eclipse
plug-in.

Benefits
Using this plug-in has following benefits compared to JFormDesigner stand-alone edition:

# Fully integrated as editor for JFormDesigner .jfd files. Create and design forms within JBuilder. No
need to switch between applications.

# Uses the source folders and classpath of the current JBuilder project. No need to specify them
twice.

® The Java code generator updates the .java file in-memory on each change in the designer. You can
design forms and edit its source code without the need to save them (as necessary when using
JFormDesigner stand-alone edition).

* Folding of generated GUI code in Java editor.

# Go to event handler method in Java editor. Double-click on the event in the Structure view to go to
the event handler method in the Java editor of JBuilder.

# Two-way synchronization of localized strings in designer and in properties file editors. Changing
localized strings in the designer immediately updates the .properties file in-memory and changing
the .properties file updates the designer.

# Copy needed libraries (JGoodies Forms, TableLayout, etc) to the project and add them to the
classpath of the current JBuilder project. Optionally include source code and javadoc.

# Convert JBuilder forms (jbInit() methods) to JFormDesigner .jfd files.

User interface

The screenshot below shows the JBuilder main window editing a JFormDesigner form.

{3 JBuilder 2005 - CiMyProject/srcicomimyapp/FormsTutorial, jfd

Fie Edt 3Search Refactor WView Project Run Team Enberprise Took Window Help Purchass
N-EE-DRHI-& M W -EHr-E-t5- -9 -0 €& B-
EEEE =R | | x|*% FomeTutora| 33 B FormsTuboriol [5o to Java code FormaTutorid java ||
BEERF = RO-=28 & @~ |3 e R
=1 N L
& MyProjectjpx - Ly Selectionode | = A : 3 - Iame Walug
T TRy PTG I k] g [y Harme Isdyed]
+ @ =Propact Source= L Maroues: Sl L - ': px: Clase | JLabal
E ‘Ebitmmmn @ Choose Bean... 3 | Fomoarms +l::nm:'rr.'|m1>:: ] CE .|
£ AdoressPanel . [ Components p Coriact background | [ 235,233, 2|
o AdcressPanal jid i - 14 : hzplayai i
= i JLabed
[Z1 Burdke deorooe H - e [+] true
< ¥ [ ITesdFiaid 7| propefier I T 1
| frg 11 = fit | M Sans Sext|
Praject | Files = W1 .| I el i, | foreground | I biack
JBtion | [ | horizontal2li.. | LEADING
. 11 R [mm} L jmm}
Erucure - 0O X 7| JChackSax eon
fH B ® JRedioBution hbeffor |
1 (torm) #| || 1T smopgesuton 1‘:‘; . | Camparry
=i | = thig [Formla | TH JTaxtiras toolTipTest | -
A poodiesFormaSep L e AL 1 el L e
i [ Certaingrs
| fedFimidt (53 Windaws
2 abet? (*Contact™) =
L fendFimid 2
== goodiesFormasSep (3 JGocdies
B bt (°FT | || C3 FeemDesigner Progestiss | Code Generstion
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A JFormDesigner editor consists of:

# Toolbar: Located at top of the editor area.
“ Palette: Located at the left side.

# Design View: Located at the center.

# Structure View: Located at the lower left.
# Properties View: Located at the right side.

# Error Log View: Automatically opens on errors in a tool window at the bottom. This view is not
visible in the above screenshot.

Creating new forms

You can create new forms using JBuilder's object gallery. Click the New arrow in the toolbar and choose
JFormDesigner Form.

(% JBuilder 2005 - C:/MyProject/MyPro
File Edit Search Refactor View Project f

DH-EE-BRT-& M|

;D Mew...

= JFormDesigner Form

Skrg+M

Application

fop Class
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In the New JFormDesigner Form dialog, enter the form name (which is also used as class name),
choose a superclass, a layout manager and set localization options.

o JFormDesigner Form Wizard @

Create a new Form

Choose a superclass, button bar and layout manager.

Mame:
Package: Oy apR b
Superclass: "EJ' JPanel {:} JDiglog {:} JFrame {:} ather

Content Pane Layout
Layout managet: FormLayout (JGoodies) b

FormLayout options

Murnber of columns: 2B
Murnber of rows: 18
inzert gap columns §rows
Localization
|:| Store strings in resource bundle (properties file)

ot myapp Bundle

[ Ok H Cancel H Helgp ]

After clicking OK, the form will be created and opened.

Open forms for editing

You can open existing forms the same way as opening any other file in JBuilder. Locate it in JBuilder's
project view and double-click it.

Go to Java code / go to form

JFormDesigner adds a button to JBuilder's main toolbar that enables you to switch quickly from a
JFormDesigner form editor to its Java editor and vice versa. If a form editor is active, then the button is

named Go to Java code (@). If a Java editor is active, then it is named Go to JFormDesigner form (
&),

Help  Purchase Help  Purchase
[ o to Java code 'FormsTutorial java' | [Go ko JFormDesigner Form 'FormsTutorial jfd' |
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Code folding

To move the generated code out of the way, JFormDesigner folds it in the Java editor.

X |23 FormaTutarial | ¥ | [E FormsTutarial

L
= public class FormsTutorial extends JPanel | =
E public FormsTutoriali) {
initComponents() ;
}
- private woid initComponenta() {
[ S JFormDesigner - Component initialization - DO NOT MODIFY //GEN-EI]
'
[ A4 JFormDesigner - Variables declaration - DO NOT MODIFY //GEN-BEGIN:wva:
! B
"
@< B

Convert JBuilder forms

You can convert existing JBuilder forms to JFormDesigner forms. Right-click on the Java file and select
Convert to JFormDesigner Form.

S

=] Burdle properties Dielete File "OptionsPanel. java" €3 Convert to JFormDesigner Form Ei
£ FormsTutorlal java

] FormsTutorial jfd

¥ Clean

wptionsPane java Cls Make

[ playground jid & Rebuild

Corwert 1 forrm to JFormDeslaner form?

[+] Generate Java cods
#3 TabbedDisiog java 2enerate Java coce
] TakibedDisiog jtd #=| Format “OptionsPanel, java® Open convarted forms
tH UFLiteParal jid 8 Convert to JFormDesigner Form,.. | | [ J
e Yeas Mo
Project | Files Properties... = =

Note: JFormDesigner inserts its own generated GUI code into the existing Java class, but does not

remove JBuilder's GUI code. You have to remove JBuilder's component variables and initialization code
yourself.

Preferences

The JFormDesigner preferences are fully integrated into the JBuilder preferences dialog. Select Tools >
Preferences from the menu to open it. See Preferences for details.

Unsupported features

Following features from other editions are not supported by the JBuilder plug-in:

“ Convert NetBeans, Intelli] IDEA and Abeille forms to JFormDesigner forms.
® Use look and feels in Design view.
# Import and export of preferences.
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4 Layout Managers

Layout managers are an essential part of Swing forms. They lay out components within a container.
JFormDesigner provides support for following layout managers:

BorderLayout
BoxLayout

“ CardLayout
FlowLayout
FormLayout (JGoodies)

* GridBaglLayout

* GridLayout

“ GrouplLayout (Free Design)
HorizontalLayout (SwingX)
Intelli]J IDEA GridLayout
null Layout

* TableLayout

* VerticalLayout (SwingX)

How to choose a layout manager?

For "normal" forms use either one of the grid-based layout managers (FormLayout, TableLayout or
GridBaglLayout) or use "Free Design" (GroupLayout). Each layout manager has its advantages and
disadvantages. FormLayout and TableLayout are open source and require that you ship an additional
library with your application.

FormLayout has the most features (dialog units, column/row alignment, column/row grouping),
but may have problems if a component span multiple columns or rows and can not handle
right-to-left component orientation.

* TableLayout does not have these limitations, but has fewer features than FormLayout.

“ GridBaglLayout is the weakest of these three grid-based layout managers, but JFormDesigner hides
its complexity and adds additional features like gaps. Use GridBaglLayout if you cannot use
FormLayout or TableLayout.

* GrouplLayout (Free Design) allows you to lay out your forms by simply placing components where
you want them. Visual guidelines suggest optimal spacing, alignment and resizing of components.

For button bars use FormLayout, TableLayout, GridBaglLayout or FlowLayout.

To layout a main window, use BorderLayout. Place the toolbar to the north, the status bar to the south
and the content to the center.

For toolbars use JTool Bar, which has its own layout manager (based on BoxLayout).

For radio button groups, BoxLayout may be a good choice. Mainly because JRadi oButt on has a gap
between its text and its border and therefore the gaps provided by FormLayout, TableLayout and
GridBaglLayout are not necessary.
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You can change the layout manager at any time. Either in the Properties view or by right-clicking on a
container in the Design or Structure view and selecting the new layout manager from the popup menu.

3
Mame Yalue
Mame this
Class JPanel
FarmLayauk {JGoodies)

background BaorderLayout

border BoxLayauk

foreground CardLayaut

kool TipTexk FlamLayauk
GridBaglayauk
aridLayout

GraupLayaut (Free Desian)
HaotizonkalLayaut (Swings)
Inkelil IDEA Gridlayouk
rull Layout

TableLayout
Werticallayouk (Swingy

Add Event Handler

Set Layout Manager

Marph Bean...

Mest in JPanel

of” Cut

= Copy

i

Rename...

¥ Delete
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4.1 BorderLayout

The border layout manager places components in up to five areas: center, north, south, east and west.
Each area can contain only one component.

Marth
Wiest  Center East

South

The components are laid out according to their preferred sizes. The north and south components may be
stretched horizontally. The east and west components may be stretched vertically. The center component
may be stretched horizontally and vertically to fill any space left over.

BorderLayout is part of the standard Java distribution.

Layout properties

A container with this layout manager has following layout properties:

Property Name Description
horizontal gap The horizontal gap between components. Default is 0.
vertical gap The vertical gap between components. Default is 0.

Constraints properties

A component contained in a container with this layout manager has following constraints properties:

Property Name Description

constraints Specifies where the component will be placed. Possible values: CENTER, NORTH, SOUTH,

EAST and WEST.
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4.2 BoxLayout

The box layout manager places components either vertically or horizontally. The components will not
wrap as in FlowLayout.

(® red () green O blue

This layout manager is used rarely. Take a look at the BoxLayout API documentation for more details
about it.

BoxLayout is part of the standard Java distribution.

Layout properties

A container with this layout manager has following layout properties:

Property Name Description
axis The axis to lay out components along. Possible values: X_AXIS, Y_AXIS, LINE_AXIS and
PAGE_AXIS.
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4.3 CardLayout

The card layout manager treats each component in the container as a card. Only one card is visible at a
time. The container acts as a stack of cards. The first component added to a CardLayout object is the
visible component when the container is first displayed.

CardLayout is part of the standard Java distribution.

Layout properties

A container with this layout manager has following layout properties:

Property Name Description
horizontal gap The horizontal gap at the left and right edges. Default is 0.
vertical gap The vertical gap at the top and bottom edges. Default is 0.

Constraints properties

A component contained in a container with this layout manager has following constraints properties:

Property Name Description

Card Name Identifier that can be used to make a card visible. See API documentation for
Car dLayout . show( Cont ai ner, String).
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4.4 FlowlLayout

The flow layout manager arranges components in a row from left to right, starting a new row if no more
components fit into a row. Flow layouts are typically used to arrange buttons in a panel.

| ok || cancel || Hep | | text || tet |[ tet |

| text || tet |

FlowLayout is part of the standard Java distribution.

Layout properties

A container with this layout manager has following layout properties:

Property Name

alignment

horizontal gap

vertical gap

align on baseline
(Java 6)

Description

The alignment of the layout. Possible values: LEFT, RIGHT, LEADING and TRAILING. Default
is CENTER.

The horizontal gap between components and between the component and the border of the
container. Default is 5.

The vertical gap between components and between the component and the border of the
container. Default is 5.

Specifies whether components are vertically aligned along their baseline. Components that do
not have a baseline are centered. Default is false.
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4.5 FormlLayout (JGoodies)

FormLayout is a powerful, flexible and precise general purpose layout manager. It places components in
a grid of columns and rows, allowing specified components to span multiple columns or rows. Not all
columns/rows necessarily have the same width/height.

1 3
1| Mame:
3| Company:

Unlike other grid-based layout managers, FormLayout uses 1-based column/row indices. And it uses
"real" columns/rows as gaps. Therefore the unusual column/row numbers in the above screenshot. Using
gap columns/rows has the advantage that you can give gaps different sizes.

Use the column and row headers to insert or delete columns/rows and change column/row properties.
JFormDesigner automatically adds/removes gap columns if you add/remove a column/row.

Compared to other layout managers, FormLayout provides following outstanding features:

Default alignment of components in a column/row.
Specification of minimum and maximum column width or row height.

Supports different units: Dialog units, Pixel, Point, Millimeter, Centimeter and Inch. Especially
Dialog units are very useful to create layouts that scale with the screen resolution.

# Column/row templates.
* Column/row grouping.

FormLayout is open source and not part of the standard Java distribution. You must ship an
additional library with your application. JFormDesigner includes forms. j ar, f or ms-j avadoc. zi p
and forns-src. zi p inits redi st folder. For more documentation and tutorials, visit
forms.dev.java.net.

IDE plug-ins: If you use FormLayout the first time, the JFormDesigner IDE plug-in ask you
whether it should copy the required library (and its source code and documentation) to the IDE
project and add it to the classpath of the IDE project.

Layout properties

A container with this layout manager has following layout properties:

Property Name Description

columnSpecs Comma separated encoded column specifications. This property is for experts only. Use the
column header instead of editing this property.

rowSpecs Comma separated encoded row specifications. This property is for experts only. Use the row
headers instead of editing this property.
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Column/row properties

Each column and row has its own properties. Use the column and row headers to change column/row
properties.

@ Column Properties E|
Colurnn: 1
Template: defaulk [default]
Specification: | default

Default alignment

Size

() constant:
[] miniriurn

[ mazirumm

Resize behavior

o left (O center () right (&) il

i) default () preferred () minimum

(¥ none
) grow
Grouping
iaroup [0 0 2% (0=nogroup)
(04 ] [ Cancel ] [ apply
Property Name Description

Column/Row

Template

Specification

Default alignment

Size

Resize behavior

Grouping

The index of the column/row. Use the arrow buttons (or Alt+Left, Alt+Right, Alt+Up,
Alt+Down keys) to edit the properties of the previous or next column/row.

FormLayout provides several predefined templates for columns and rows. Here you can
choose one.

The column/row specification. This is a string representation of the options below.

The default alignment of the components within a column/row. Used if the value of the
component constraint properties "h align” or "v align" are set to DEFAULT.

The width of a column or height of a row. You can use default, preferred or minimum
component size. Or a constant size. It is also possible to specify a minimum and a maximum
size. Note that the maximum size does not limit the column/row size if the column/row can
grow (see resize behavior).

The resize weight of the column/row.

See column/row grouping for details.

Tip: The column/row context menu allows you to alter many of these options for multi-selections.

Constraints properties

A component contained in a container with this layout manager has following constraints properties:
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Description

Specifies the component's horizontal grid origin (column index).

Specifies the component's vertical grid origin (row index).

Specifies the component's horizontal grid extend (number of columns). Default is 1.
Specifies the component's vertical grid extend (number of rows). Default is 1.

The horizontal alignment of the component within its cell. Possible values: DEFAULT, LEFT,
CENTER, RIGHT and FILL. Default is DEFAULT.

The vertical alignment of the component within its cell. Possible values: DEFAULT, TOP,
CENTER, BOTTOM and FILL. Default is DEFAULT.

Specifies the external padding of the component, the minimum amount of space between the
component and the edges of its display area. Default is [0,0,0,0].

Note that the insets do not increase the column width or row height (in contrast to the
GridBagConstraints.insets).

Tip: The component context menu allows you to alter the alignment for multi-selections.

4.5.1 Column/Row Templates

FormLayout provides several predefined templates for columns and rows. You can also define custom
column/row templates in the Preferences dialog.

Column templates

Name

default

preferred

minimum

related gap

unrelated gap
label component gap

glue

button

growing button

Description Gap

Determines the column width by computing the maximum of all column component  no
preferred widths. If there is not enough space in the container, the column can
shrink to the minimum width.

Determines the column width by computing the maximum of all column component no
preferred widths.

Determines the column width by computing the maximum of all column component no
minimum widths.

A logical horizontal gap between two related components. For example the OK yes
and Cancel buttons are considered related.

A logical horizontal gap between two unrelated components. yes
A logical horizontal gap between a label and an associated component. yes
Has an initial width of O pixels and grows. Useful to describe glue columns that fill  yes
the space between other columns.

A logical horizontal column for a fixed size button. no
A logical horizontal column for a growing button. no
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Row templates

Name Description Gap

default Determines the row height by computing the maximum of all row component no
preferred heights. If there is not enough space in the container, the row can shrink
to the minimum height.

preferred Determines the row height by computing the maximum of all row component no
preferred heights.

minimum Determines the row height by computing the maximum of all row component no
minimum heights.

related gap A logical vertical gap between two related components. yes

unrelated gap A logical vertical gap between two unrelated components. yes

narrow line gap A logical vertical narrow gap between two rows. Useful if the vertical space is yes
scarce or if an individual vertical gap shall be smaller than the default line gap.

line gap A logical vertical default gap between two rows. A little bit larger than the narrow yes
line gap.

paragraph gap A logical vertical default gap between two paragraphs in the layout grid. This gap yes

is larger than the default line gap.

glue Has an initial height of O pixels and grows. Useful to describe glue rows that fill the yes
space between other rows.

4.5.2 Column/Row Groups

Column and row groups are used to specify that a set of columns or rows will get the same width or
height. This is an essential feature for symmetric, and more generally, balanced design.

1 3 2] v
. : ] I

1| General

3 Campary

4] Contact

7| Propeller

a PTI [k Porveer [KiY]
11 F: [tnm] D [mm]

In the above example, columns [1 and 5] and columns [3 and 7] have the same width.

To visualize the grouping, JFormDesigner displays lines connecting the grouped columns/rows near to the
column and row headers.
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Group columns/rows

To create a new group, select the columns/rows you want to group in the header, right-click on a
selected column/row in the header and select Group from the popup menu.

=1 = 5

Insert Calurmn

1| General Delete Calurmns
3| Company Delete Contents
5 Contact Split Calurmn
7| Propeller + Left
| PTI[kvy] Povwver | #* Center
11 R[mm] D[ ® ~ Right
= Fill
FoGrow
Defaulk
Preferred
Minirnurn
Button

arowing butkon

Cther F

BT

Note that selected gap columns/rows will be ignored when grouping.

You can extend existing groups by selecting at least one column/row of the existing group and the
columns/rows that you want to add to that group, then right-click on a selected column/row and select
Group from the popup menu.

Ungroup columns/lines

To remove a group, select all columns/rows of the group, right-click on a selected column/row and select
Ungroup from the popup menu.

To remove a column/row from a group, right-click on it and select Ungroup from the popup menu.

Group IDs

A unique group ID identifies each group. When using the header context menu to group/ungroup, you
don't have to care about those IDs. JFormDesigner manages the group IDs automatically.

However it is possible to edit the group ID in the Column/row properties dialog.
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4.6 GridBaglLayout

The grid bag layout manager places components in a grid of columns and rows, allowing specified
components to span multiple columns or rows. Not all columns/rows necessarily have the same
width/height. Essentially, GridBaglLayout places components in rectangles (cells) in a grid, and then uses
the components' preferred sizes to determine how big the cells should be.

u] 1
0 Mame:
1| Company:

Use the column and row headers to insert or delete columns/rows and change column/row properties.

GridBaglLayout is part of the standard Java distribution.

Extensions
JFormDesigner extends the original GridBaglLayout with following features:

Horizontal and vertical gaps

Simply specify the gap size and JFormDesigner automatically computes the

Gri dBagConstraints. i nsets for all components. This makes designing a form with consistent
gaps using GridBaglLayout much easier. No longer wrestling with Gri dBagConstrai nts. i nsets.

With gaps: Without gaps:
Marme: Marme:
COmpay; Campary:

Left/top layout alignment
The pure GridBaglLayout centers the layout within the container if there is enough space.
JFormDesigner easily allows you to fix this problem by switching on two options: align left and

align top.
With layout alignment: Without layout alignment:
Marme:
Mame:
Campany:
Carmpany.

Default component alignment

Allows you to specify a default alignment for components within columns/rows. This is very useful
for columns with right aligned labels because you specify the alignment only once for the column
and all added labels will automatically aligned to the right.

Layout properties

A container with this layout manager has following layout properties:

Property Name Description

horizontal gap The horizontal gap between components. Default is 5.

vertical gap The vertical gap between components. Default is 5.

align left If true, aligns the layout to the left side of the container. If false, then the layout is centered

horizontally. Default is true.

align top If true, aligns the layout to the top side of the container. If false, then the layout is centered
vertically. Default is true.
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These four properties are JFormDesigner extensions to the original GridBagLayout. However, no
additional library is required.

Column/row properties

Each column and row has its own properties. Use the column and row headers to change column/row
properties.

o 5
Column: 0 im Fow: 0 +

Default alignment Default alignment
1 left (T center () right G Fll (top (O center () batkom () il
i () baseline () above baseline () below baseline  (lava &)
Minirmurmn: 0 % | pixel Size
Resize behavior it 0% pixel
{*) none Resize behavior
O grow (%) none
) grow
I oK l [ Cancel ] [ Apply ] [ (0] 4 ] [ Cancel ] [ Apply
Property Name Description
Column/Row The index of the column/row. Use the arrow buttons (or Alt+Left, Alt+Right, Alt+Up,
Alt+Down keys) to edit the properties of the previous or next column/row.
Default alignment The default alignment of the components within a column/row. Used if the value of the
constraints properties "h align” or "v align" is DEFAULT.
Size The minimum width of a column or height of a row.
Resize behavior The resize weight of the column/row.

Tip: The column/row context menu allows you to alter many of these options for multi-selections.

Constraints properties

A component contained in a container with this layout manager has following constraints properties:

Property Name Description

grid x Specifies the component's horizontal grid origin (column index).

gridy Specifies the component's vertical grid origin (row index).

grid width Specifies the component's horizontal grid extend (number of columns). Default is 1.

grid height Specifies the component's vertical grid extend (number of rows). Default is 1.

h align The horizontal alignment of the component within its cell. Possible values: DEFAULT, LEFT,

CENTER, RIGHT and FILL. Default is DEFAULT.

v align The vertical alignment of the component within its cell. Possible values: DEFAULT, TOP,
CENTER, BOTTOM, FILL, BASELINE (Java 6), ABOVE_BASELINE (Java 6) and
BELOW_BASELINE (Java 6). Default is DEFAULT.

weight x Specifies how to distribute extra horizontal space. Default is 0.0.
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Description

weight y Specifies how to distribute extra vertical space. Default is 0.0.

insets Specifies the external padding of the component, the minimum amount of space between the
component and the edges of its display area. Default is [0,0,0,0].

ipad x Specifies the internal padding of the component, how much space to add to the minimum
width of the component. Default is O.

ipad y Specifies the internal padding, that is, how much space to add to the minimum height of the
component. Default is 0.

In contrast to the GridBagConstraints API, which uses anchor and fi |l | to specify the alignment and

resize behavior of a component, JFormDesigner uses the usual h/ v al i gn notation.

Tip: The component context menu allows you to alter the alignment for multi-selections.
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4.7 GridLayout

The grid layout manager places components in a grid of cells. Each component takes all the available
space within its cell, and each cell is exactly the same size.

This layout manager is used rarely.

GridLayout is part of the standard Java distribution.

Layout properties

A container with this layout manager has following layout properties:

Property Name Description
columns The number of columns. Zero means any number of columns.
rows The number of rows. Zero means any number of rows.

Note: If the number of rows is non-zero, the number of columns specified is ignored. Instead,
the number of columns is determined from the specified number or rows and the total number
of components in the layout.

horizontal gap The horizontal gap between components. Default is 0.

vertical gap The vertical gap between components. Default is 0.
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4.8 GrouplLayout (Free Design)

The goal of the group layout manager is to make it easy to create professional cross platform layouts. It
is designed for GUI builders, such as JFormDesigner, to use the "Free Design" paradigm. You can lay out
your forms by simply placing components where you want them. Visual guidelines suggest optimal
spacing, alignment and resizing of components.

Rnimation

[] animate layout changes in Design view

E—a——n
gnimation speed: () fast 87 defaulte™) slow

E——a—B
Other

[ ] Buffer Design view in video memary

Undao histary size: 1.000 %

GroupLayout has been developed by the NetBeans team and is also used by the NetBeans GUI Builder
(formerly Project Matisse). They provide a comprehensive tutorial on designing GUIs using GrouplLayout,
which is also suitable for JFormDesigner: http://www.netbeans.org/kb/60/java/quickstart-gui.html

GrouplLayout is part of the standard Java distribution since Java 6. If you need to run your
application also on Java 5 or 1.4, you can use the open-source Swing Layout Extension library,
which is compatible to the Java 6 GrouplLayout, but uses different package names. Change the
option "GroupLayout Generation Style" in the Layout Managers (Java Code Generator)
preferences if necessary.

IDE plug-ins: If you use GrouplLayout from the Swing Layout Extension library the the first
time, the JFormDesigner IDE plug-in ask you whether it should copy the required library (and its
source code and documentation) to the IDE project and add it to the classpath of the IDE project.

Alignment guidelines

Alignment guidelines appear only when adding or moving components. They indicate the preferred
positions to which components snap when releasing the mouse button.

Insets are the preferred spacings between components and their container.

%;}
Snap at the preferred distance From the container's left border.
Snap at the preferred distance from the conkainer's upper border,

Offsets are the preferred spacings between adjacent components.

Mame:

%J

|Sna|:| at the small preferred distance Fram a camponent on the lefk, |
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Baseline alignment is the preferred relationship between adjacent components that display text.

Marme: [%

&

|.ﬁ.lign on the baseline with another component,

Edge alignments (top, bottom, left and right) are possible relationships between adjacent components.

Marme: l%

o2

|.ﬁ.lign with the tap side of another component,

Marme:

s

)

[ Aligr with the left side of another componert, |

Indentation alignment is a special alignment relationship in which one component is located below
another and offset slightly to the right.

Mame:

Ly

&
Indent the component.
Snap at the small preferred distance from a component abowe,

Anchoring indicators

Anchoring indicators appear when components have snapped into position. They illustrate the alignment
and relationship among components.

E—E—N
mlames Marme:;

Anchors connecting components to their container or to adjacent components are represented by small
semi-circular indicators with dashed lines.

Commands

The designer context menu provides following GroupLayout specific commands:

Command Description
== Alignin Aligns the selected components left/right/top/bottom/center in column/row.
column/row
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[++] Same Width
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Set Default Size

Space Around
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Description

Aligns the selected components left/right/top/bottom.

Changes the anchoring of the selected components. A component is usually horizontally
anchored left/right and vertically anchored top/bottom. Anchoring connects a component
to a container edge or a neighborhood component edge.

Makes the selected components resize horizontally at runtime if the container size
changes.

Makes the selected components resize vertically at runtime if the container size changes.

Makes the selected components all the same width. If one of the selected components is
already in a group of "Same Width" components, the other components are added to the
existing group. To remove components from a group, select them and then execute this
command. Grouped components are marked with a small indicator.

H

=
K, ] [ Zancel

Makes the selected components all the same height. See "Save Width" command for
more details.

Makes the selected components have its default size.

Changes the empty space around the selected component.

Layout properties

A container with this layout manager has following layout properties:

Property Name

honors visibility

Description

Specifies whether component visibility is considered when positioning and sizing components.
If true, non-visible components are not treated as part of the layout. If false, components are
positioned and sized regardless of visibility. Default is true.

Constraints properties

A component contained in a container with this layout manager has following constraints properties:

Property Name

horizontal size

vertical size

horizontal resizable

vertical resizable

Description

Specifies the component's horizontal size in pixel or Default. If set to Default, the component's
preferred width is used. Default is Default.

Specifies the component's vertical size in pixel or Default. If set to Default, the component's
preferred height is used. Default is Default.

Specifies whether the component is horizontal resizable. Default is false.

Specifies whether the component is vertical resizable. Default is false.
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4.9 HorizontalLayout (SwingX)

The horizontal layout manager places components horizontally. The components are stretched vertically
to the height of the container. The components will not wrap as in FlowLayout.

[ K H Cancel H Help ]

HorizontalLayout is part of the SwingX open source project and not part of the standard Java
distribution. You must ship an additional library with your application. The JFormDesigner
distribution does not include the SwingX library. For downloads, documentation and tutorials,

visit www.swinglabs.org.

Layout properties

A container with this layout manager has following layout properties:

Property Name Description

gap The horizontal gap between components. Default is 0.
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4.10 IntelliJ IDEA GridLayout

The Intelli] IDEA grid layout manager places components in a grid of columns and rows, allowing
specified components to span multiple columns or rows. Not all columns/rows necessarily have the same
width/height.

Note: The IntelliJ IDEA grid layout manager is supported to make it easier to migrate forms, which were
created with IntelliJ IDEA's GUI builder. If you never used it, it is recommended to use one of the other
grid-based layout managers.

0 1
0| Mame:
1| Company:

;T I——

Use the column and row headers to insert or delete columns/rows and change column/row properties.
Use horizontal and vertical spacers, which are available in the Palette, to define space between
components.

Intelli] IDEA GridLayout is open source and not part of the standard Java distribution. You must
ship an additional library with your application. JFormDesigner includesintellij forns_rt.jar
andintellij _forms_rt_src.zipinits redist folder. For more documentation and tutorials,
visit www.jetbrains.com/idea/.

IDE plug-ins: If you use Intelli] IDEA GridLayout the first time, the JFormDesigner IDE plug-in
ask you whether it should copy the required library (and its source code) to the IDE project and
add it to the classpath of the IDE project.

Layout properties

A container with this layout manager has following layout properties:

Property Name Description

horizontal gap The horizontal gap between components. If -1, then inherits gap from parent container that
also uses IntelliJ IDEA GridLayout, or uses 10 pixel. Default is -1.

vertical gap The vertical gap between components. If -1, then inherits gap from parent container that also
uses IntelliJ IDEA GridLayout, or uses 5 pixel. Default is -1.

same size horizontally If true, all columns get the same width. Default is false.
same size vertically If true, all rows get the same height. Default is false.

margin Size of the margin between the containers border and its contents. Default is 0, 0, 0, O.

Constraints properties

A component contained in a container with this layout manager has following constraints properties:

Property Name Description

grid x Specifies the component's horizontal grid origin (column index).

gridy Specifies the component's vertical grid origin (row index).

grid width Specifies the component's horizontal grid extend (number of columns). Default is 1.
grid height Specifies the component's vertical grid extend (number of rows). Default is 1.
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fill

anchor

indent

align grid with parent

horizontal size policy

vertical size policy

minimum size
preferred size

maximum size
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Description

Specifies how the component fills its cell. Possible values: None, Horizontal, Vertical and Both.
Default is None.

Specifies how the component is aligned within its cell. Possible values: Center, North, North
East, East, South East, South, South West, West and North West. Default is Center.

The indent of the component within its cell. In pixel multiplied by 10. Default is 0.

If true, align the grid of nested containers, which use IntelliJ IDEA GridLayout, with the grid of
this container. Default is false.

Specifies how the component affects horizontal resizing behavior. Possible values: Fixed, Can
Shrink, Can Grow, Want Grow and combinations. Default is Can Shrink and Can Grow.

Specifies how the component affects vertical resizing behavior. Possible values: Fixed, Can
Shrink, Can Grow, Want Grow and combinations. Default is Can Shrink and Can Grow.

The minimum size of the component. Default is -1, -1.
The preferred size of the component. Default is -1, -1.

The maximum size of the component. Default is -1, -1.
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4.11 null Layout

null layout is not a real layout manager. It means that no layout manager is assigned and the
components can be put at specific x,y coordinates.

Marne:

[ text

text

[ Jtext

It is useful for making quick prototypes. But it is not recommended for production because it is not
portable. The fixed locations an sizes do not change with the environment (e.g. different fonts on various
platforms).

Preferred sizes
JFormDesigner supports preferred sizes of child components. This solves one common problem of null

layout: the component sizes change with the environment (e.g. different fonts on various platforms).
Unlike other GUI designers, no additional library is required.

Grid

To make it easier to align components, the component edges snap to an invisible grid when moving or
resizing components. You can specify the grid step size in the Preferences dialog. To temporary disable
grid snapping, hold down the Shift key while moving or resizing components.

Keyboard

You can move selected components with Ctrl+ArrowKey and change size with Shift+ArrowKey.

Aligning components

The align commands help you to align a set of components or make them same width or height.

H—E—N
LIl
S | Align Left Alk+Left
:;15 = Align Center Alt+Home
1
:_ =| align Right Alk+Right
T &lign Top Alt+Up
i &lign Middle alt+End
il &lign Botkarm Alk4-Crovn
= same Width Chrl+alk-+Right
Tilll 5ame Height ChrH-AlE+Davn
[+#| Make Horizontal Space Equal  Crrl+alk+Left
T Make Vertical Space Equal Crrl+Al+Up

The dark blue handles in the above screenshot indicate the first selected component.

Command Description
[= Align Left Line up the left edges of the selected components with the left edge of the first selected
component.
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Description

Horizontally line up the centers of the selected components with the center of the first
selected component.

Line up the right edges of the selected components with the right edge of the first selected
component.

Line up the top edges of the selected components with the top edge of the first selected
component.

Vertically line up the centers of the selected components with the center of the first selected
component.

Line up the bottom edges of the selected components with the bottom edge of the first
selected component.

Make the selected components all the same width as the first selected component.
Make the selected components all the same height as the first selected component.

Makes the horizontal space between 3 or more selected components equal. The leftmost and
rightmost components stay unchanged. The other components are horizontally distributed
between the leftmost and rightmost components.

Makes the vertical space between 3 or more selected components equal. The topmost and
bottommost components stay unchanged. The other components are vertically distributed
between the topmost and bottommost components.

Layout properties

A container with this layout manager has following layout properties:

Property Name

auto-size

Description

If true, computes the size of the container so that all children are entire visible. If false, the size
of the container in the Design view is used. Default is true.

Constraints properties

A component contained in a container with this layout manager has following constraints properties:

Property Name

X

y

width

height

Description
The x coordinate of the component relative to the left corner of the container.
The y coordinate of the component relative to the upper corner of the container.

The width of the component in pixel or Preferred. If set to Preferred, the component's preferred
width is used. Default is Preferred.

The height of the component in pixel or Preferred. If set to Preferred, the component's
preferred width is used. Default is Preferred.
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4.12 TableLayout

The table layout manager places components in a grid of columns and rows, allowing specified
components to span multiple columns or rows. Not all columns/rows necessarily have the same
width/height.

A column/row can be given an absolute size in pixels, a percentage of the available space, or it can grow
and shrink to fill the remaining space after other columns/rows have been resized.

u} 1
0 Mame:
1| Company:

Use the column and row headers to insert or delete columns/rows and change column/row properties.

TableLayout is open source and not part of the standard Java distribution. You must ship an
additional library with your application. JFormDesigner includes Tabl eLayout . j ar,

Tabl eLayout -j avadoc. j ar and Tabl eLayout -src. zi p in its redi st folder. For more
documentation and tutorials, visit tablelayout.dev.java.net.

IDE plug-ins: If you use TableLayout the first time, the JFormDesigner IDE plug-in ask you

whether it should copy the required library (and its source code and documentation) to the IDE
project and add it to the classpath of the IDE project.

Extensions
JFormDesigner extends the original TableLayout with following features:
Default component alignment
Allows you to specify a default alignment for components within columns/rows. This is very useful

for columns with right aligned labels because you specify the alignment only once for the column
and all added labels will automatically aligned to the right.

Layout properties

A container with this layout manager has following layout properties:

Property Name Description
horizontal gap The horizontal gap between components. Default is 5.
vertical gap The vertical gap between components. Default is 5.

-108 -


http://tablelayout.dev.java.net/

JFormDesigner 4.0.2 Manual

Column/row properties

Each column and row has its own properties. Use the column and row headers to change column/row
properties.

@ Column Properties @

Colurnn: 0
Default alignment
) left (T center () right (&) Fll
Size
@ preferred
) minimurm
) arow
) pixel pixel
() percentage %
[ Ik ] [ Cancel ] [ Apply
Property Name Description
Column/Row The index of the column/row. Use the arrow buttons (or Alt+Left, Alt+Right, Alt+Up,
Alt+Down keys) to edit the properties of the previous or next column/row.
Default alignment The default alignment of the components within a column/row. Used if the value of the
constraints properties "h align” or "v align" is DEFAULT.
Size Specifies how TableLayout computes the width/height of a column/row.

Tip: The column/row context menu allows you to alter many of these options for multi-selections.

Constraints properties

A component contained in a container with this layout manager has following constraints properties:

Property Name Description

grid x Specifies the component's horizontal grid origin (column index).

gridy Specifies the component's vertical grid origin (row index).

grid width Specifies the component's horizontal grid extend (number of columns). Default is 1.

grid height Specifies the component's vertical grid extend (number of rows). Default is 1.

h align The horizontal alignment of the component within its cell. Possible values: DEFAULT, LEFT,

CENTER, RIGHT and FILL. Default is DEFAULT.

v align The vertical alignment of the component within its cell. Possible values: DEFAULT, TOP,
CENTER, BOTTOM and FILL. Default is DEFAULT.

In contrast to the TableLayoutConstraints API, which uses [column1,rowl,column2,row2] to specify the
location and size of a component, JFormDesigner uses the usual [x,y,width,height] notation.

Tip: The component context menu allows you to alter the alignment for multi-selections.
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4.13 VerticalLayout (SwingX)

The vertical layout manager places components vertically. The components are stretched horizontally to
the width of the container.

K
Cancel

Help

VerticalLayout is part of the SwingX open source project and not part of the standard Java
distribution. You must ship an additional library with your application. The JFormDesigner
distribution does not include the SwingX library. For downloads, documentation and tutorials,

visit www.swinglabs.org.
Layout properties
A container with this layout manager has following layout properties:

Property Name Description

gap The vertical gap between components. Default is 0.
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5 Java Code Generator

JFormDesigner can generate and update Java source code. It uses the same name for the Java file as for
the Form file. E.g.:

C:\ MyProj ect\ src\com nyproj ect\ Wl coneDi al og. j fd (form file)
C:\ MyProj ect\ src\ com nyproj ect\ Wl coneDi al og. j ava (java file)

Stand-alone: Before creating new forms, you should specify the locations of your Java source folders in
the Project dialog. Then JFormDesigner can generate valid package statements. For the above example,
you should add C:\ MyProj ect\src.

IDE plug-ins: The source folders of the IDE projects are used.

If the Java file does not exist, JFormDesigner generates a new one. Otherwise it parses the existing Java
file and inserts/updates the code for the form and adds import statements if necessary.

Stand-alone: The Java file will be updated when saving the form file.

IDE plug-ins: If the Java file is opened in the IDE editor, it will be immediately updated in-memory on
each change in JFormDesigner. Otherwise it will be updated when saving the form file.

JFormDesigner uses special comments to identify the code sections that it will generate/update. E.g.:

/'l JFornmDesigner - ... //GEN-BEGQ N: i ni t Conponent s
/1 JFormDesigner - ... //CEN END:initConponents

The starting comment must contain GEN- BEG N: <keywor d>, the ending comment GEN- END: <keywor d>.
These comments are NetBeans compatible. The text before GEN- BEG N and GEN- END (in the same line)
does not matter. JFormDesigner uses the following keywords:

Keyword name Description

initComponents Used for code that instantiates and initializes the components of the form.
variables Used for code that declares the class level variables for components.
initl18n Used for code that initializes localized component properties.
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5.1 Nested Classes

One of the advanced features of JFormDesigner is the generation of nested classes. Normally, all code for
a form is generated into one class. If you have forms with many components, e.g. a JTabbedPane with

some tabs, it is not recommended to have only one class. If you hand-code such a form, you would
create a class for each tab.

In JFormDesigner you can specify a nested class for each component. You do this on the Code

Generation tab in the Properties view. JFormDesigner automatically generates/updates the specified
nested classes. This allows you to program more object-oriented and makes your code easier to read and
maintain.

= - & Properties B o B
Marme “alue
= @this [BorderLayaut] Mested Clazs Marme
= D tabbedPane [ TabbedPans] “ariable Marme tak Panel
= @ abrl Panel [FormbayoLt] “ariable Modifiers private
0] label2 Mext™) Use Local Variable | [ ] false
-I_- textField Gen. Getter Method |:| falze
= @ tab2Panel [Formlayout] “ariable Annotatio. .
0] label3 [Ment™) Type Parameters (J..

v{ 1 11}
checkBiox1 (text") Propetties | Code Generation

Components having a nested class are marked with a @ overlay symbol in the Structure view.

Example source code:

public class Nestedd assDenp
ext ends JPanel
{
publ i c Nestedd assDenp() {
i ni t Conponents();
}

private void initConponents() {

/1 JFornDesi gner - Conponent initialization - DO NOT MODI FY //GEN BEG N:init Cor

t abbedPane = new JTabbedPane();

tablPanel = new TablPanel ();
tab2Panel = new Tab2Panel ();
| | ======== thi s ========

t abbedPane. addTab("tab 1", tablPanel);
t abbedPane. addTab("tab 2", tab2Panel);

}
add(t abbedPane, BorderLayout. CENTER);
/'l JFornDesi gner - End of conponent initialization //GEN END:initConponents

}

/1 JFornDesigner - Variables declaration - DO NOT MODI FY //GEN BEG N: vari abl es
private JTabbedPane tabbedPane;

private TablPanel tablPanel;

private Tab2Panel tab2Panel ;

/1 JFornDesigner - End of variables declaration //GEN-END:vari ables

[/---- nested class TablPanel --------------moommmm e

private class TablPanel
ext ends JPanel
{

private TablPanel () {
i ni t Conponents();
}
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private void initConmponents() {
/1 JFornDesi gner - Conponent initialization - DO NOT MODI FY //GEN BEGQ N: i ni
| abel 2 = new JLabel ();
textFieldl = new JTextField();
Cel | Constraints cc = new Cel |l Constraints();

set Bor der ( Bor der s. TABBED_DI ALOG_BORDER) ;
set Layout (new FornlLayout( ... ));
//---- label2 ----

| abel 2. set Text ("text");
add(l abel 2, cc.xy(1, 1));

/l---- textFieldl ----

add(textFieldl, cc.xy(3, 1));

/1 JFornDesi gner - End of conponent initialization //GEN END:initConponents
}

/1 JFornDesi gner - Variables declaration - DO NOT MODI FY //GEN BEG N: vari abl es
private JLabel | abel 2;

private JTextField textFieldl;

/1 JFornDesigner - End of variables declaration //GEN-END:vari abl es

}

[/---- nested class Tab2Panel -------------------oo o

private class Tab2Panel
ext ends JPanel
{

private Tab2Panel () {
i ni t Conponents();
}

private void initConmponents() {
/'l JFornDesi gner - Conponent initialization - DO NOT MODI FY //GEN BEG N:i ni
| abel 3 = new JLabel ();
checkBox1l = new JCheckBox();
Cel | Constraints cc = new Cel |l Constraints();

set Bor der ( Bor der s. TABBED DI ALOG_BORDER) ;
set Layout (new FornmLayout ( ... ));

[[---- |abel3 ----

| abel 3. set Text ("text");
add(| abel 3, cc.xy(1, 1));

/l---- checkBox1 ----

checkBox1. set Text ("text");

add(checkBox1, cc.xy(3, 1));

/1 JFornDesi gner - End of conponent initialization //GEN END:initConponents
}

/1 JFornDesi gner - Variables declaration - DO NOT MODI FY //GEN BEG N: vari abl es
private JLabel | abel 3;

private JCheckBox checkBox1;

/1 JFornDesigner - End of variables declaration //GEN-END:vari ables

When changing the nested class nhame on the Code Generation tab (Properties view), JFormDesigner
also renames the nested class in the Java source code. When removing the nested class name, then
JFormDesigner does not remove the nested class in the Java source code to avoid loss of own source
code.
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5.2 Code Templates

When generating new Java files or classes, JFormDesigner uses the templates specified in the Preferences

dialog.

Template name

File header

Class

Empty Class

Event Handler Body

Component initialization

Variables declaration

java.awt.Dialog

javax.swing.AbstractAction

Description

Used when creating new Java files. Contains a header comment and a package
statement.

Used when generating a new (nested) class. Contains a class declaration, a constructor,
a component initialization method and variable declarations.

Used when generating a new empty class. This can happen, if all form components are
contained in nested classes.

Used for event handler method bodies.

Replaces the variable ${component_initialization} used in other templates. Contains a
method named i ni t Conponent s. Invoke this method from your code to instantiate the
components of your form. Feel free to change the method name if you don't like it.

Replaces the variable ${variables_declaration} used in other templates.

A template for classes derived from j ava. awt . Di al og. Compared to the “Class”
template, this has special constructors, which are necessary for j ava. awt . Di al og
derived classes.

Used for nested action classes.

You can change the existing templates or create additional templates in the Preferences dialog. It is
possible to define your own templates for specific superclasses.

Following variables can be used in the templates:

Variable name
${date}
${user}

${package_declaration}

${class_name}
${component_initialization}
${constructor_modifiers}
${extends_declaration}

${modifiers}

${variables_declaration}

Description Context
Current date. global
User name. global
package statement. If the form is not saved under one of the source folders file

specified in the Project dialog, the variable is empty (no package statement will header
be generated).

Name of the (nested) class. class
See template “Component initialization”. class
Modifiers of the constructor. Based on the class modifiers. class
The ext ends declaration of the class; empty if the class has no superclass. class
Modifiers of the (nested) class. You can specify the default modifiers in the class

Preferences dialog.

See template “Variables declaration”. class
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5.3 Command Line Generation

Usually its not necessary to run the Java code generator from command-line because the Java code is
automatically generated and updated while editing a form in JFormDesigner. However in rare cases it is
useful to re-generate the Java code of JFormDesigner forms. E.g. if you want upgrade to JGoodies
FormLayout 1.2, which introduced a new much shorter syntax for encoded column and row specifications.

Requirements

You need an installation of the JFormDesigner stand-alone edition. If you usually use one of the IDE
editions, then simply download the stand-alone edition and install it.

Preferences

The command-line Java code generator uses the preferences store of the stand-alone edition. If you use
one of the IDE editions of JFormDesigner, you have to start the stand-alone edition and set the necessary
preferences for the code generation. To transfer JFormDesigner preferences from an IDE to the
stand-alone edition, you can use the Import and Export buttons in the Preferences dialogs. Make sure
that the Code Style preferences are correct because they are not transfered from a IDE.

Command Line Syntax

Launch the code generator as follows, where [ ] means optional arguments and arguments in italics must
be provided by you.

java -classpath <jfd-install>/lib/JFormDesigner.jar
com.jformdesigner.application.JavaCodeGeneratorMain
[-r] [-v]
[ <project-path>/MyProject.jfdproj]
<folder> or <path>/MyForm1.jfd [...]

Option Description

-classpath <jfd-install>/lib/JFormDesigner.jar Specifies the JAR that contains the Java code generator.
This is a standard argument of the Java application launcher.

com.jformdesigner.application.JavaCodeGeneratorMain The class name of the Java code generator.

-r Recursively process folders.
-V Prints file names of processed .jfd files to the console.
<project-path>/MyProject.jfdproj Optional JFormDesigner stand-alone edition project used to

extend the classpath for the code generation. Useful when
using custom components.

<folder> or <path>/MyForm1.jfd [...] List of folders or .jfd files. If a folder is specified, all .jfd files in
the folder are processed.

Using custom components

If you're using custom components (JavaBeans) in your forms, it is necessary to tell the code generator
the classpath of your components, because the code generator needs to load the classes of custom
components. There are two options to specify the classpath for your custom components:

* JFormDesigner stand-alone edition project: The JARs and folders specified on the Classpath page
in the project settings are used by the code generator. This is the preferred way is you use the
stand-alone edition.

* Classpath of Java application launcher: Simply add your JARs to the -classpath option of the Java
application launcher. This is the preferred way if you use Ant (see below) or one of the IDE editions
(which don't use JFormDesigner project files).
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Examples
Generate code for a single form:

cd C:\MyProject

java -classpath C:\ProgramFiles\JFormDesigner\lib\JFormDesigner.jar
com.jformdesigner.application.JavaCodeGeneratorMain
src/com/myproject/MyForm1.jfd

Generate code for all forms in a project that use custom components:

cd C:\MyProject

java -classpath C:\ProgramFiles\JFormDesigner\lib\JFormDesigner.jar, classes,;swingx.jar
com.jformdesigner.application.JavaCodeGeneratorMain
-r src

Ant

Although we don't provide a special task for Ant, it is easy to invoke the JFormDesigner Java code
generator from an Ant script. The <classpath> element makes it easy to specify JARs and folders of
custom components.

<property name="javacodegen_command_line_html__jfd-install-dir" value="C:/Program
Files/JFormDesigner"/>

<java
classname="javacodegen_command_line_html__com.jformdesigner.application.JavaCodeGeneratorMair

fork="true" failonerror="true" logError="true">

<classpath>
<pathelement location="${jfd-install-dir}/lib/JFormDesigner.jar"/>
<pathelement location="myLibrary.jar"/>

</classpath>

<arg value="-r"/>

<arg value="src"/>

</java>
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6 Runtime Library

Note: If you use the Java code generator, you don't need this library.

The open-source (BSD license) runtime library allows you to load JFormDesigner XML files at runtime
within your applications. Turn off the Java code generation in the Preferences dialog if you use this
library.

You'll find the library j fd- 1 oader. j ar in the redi st folder (or plug-in) of the JFormDesigner
installation; the source code is in jfd-loader-src.zip; the documentation is in
j fd-1 oader -j avadoc. zi p and an example in the exanpl es folder or exanpl es. zi p archive.

Classes

For nLoader provides methods to load JFormDesigner .jfd files into in-memory form models.

For nCr eat or creates instances of Swing components from in-memory form models and provides
methods to access components.

For nBaver saves in-memory form models to JFormDesigner .jfd files. Can be used to convert
proprietary form specifications to JFormDesigner .jfd files: first create a in-memory form model
from your form specification, then save the model to a .jfd file.

Example

The following example demonstrates the usage of FormLoader and FormCreator. It is included in the
examples distributed with all JFormDesigner editions.

public class Loader Exanpl e

{

private JDi al og di al og;

public static void main(String[] args) {
new Loader Exanpl e();
}

Loader Exanpl e() {
try {
/1 load the .jfd file into nmenory
For mvbdel formvbdel = Fornloader. | oad(
"cont j f or ndesi gner/ exanpl es/ Loader Exanpl e.j fd");

/'l create a dialog

FornCreator fornCreator = new FornCreator (formvbdel);
fornmCreator. setTarget(this);

dialog = fornCreator.createDi al og(null);

/1 get references to conponents
JText Fi el d nameFi el d = forntCreator. get Text Fi el d("naneFi el d");
JCheckBox checkBox = fornCreator. get CheckBox("checkBox");

/'l set val ues
naneFi el d. set Text ("enter nane here");
checkBox. set Sel ect ed(true);

/' show di al og
di al og. set Modal (true);
di al og. pack();
di al og. show();

System out . printl n(nanmeFi el d. get Text ());
System out . println(checkBox.isSel ected());
System exit (0);

} catch(Exception ex) {
ex. printStackTrace();

-117 -



JFormDesigner 4.0.2 Manual

}

/'l event handler for checkBox
private void checkBoxActi onPerformed(Acti onEvent e) {

JOpt i onPane. showMessageDi al og(di al og, "check box clicked");
}

/1 event handler for okButton

private void okButtonActionPerfornmed() {
di al og. di spose();

}
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7 JavaBeans

What is a Java Bean?
A Java Bean is a reusable software component that can be manipulated visually in a builder tool.
JavaBean (components) are self-contained, reusable software units that can be visually composed into

composite components and applications. A bean is a Java class that has:

a "null" constructor (without parameters)
properties defined by getter and setter methods.

JFormDesigner supports:

“ Visual beans (must inherit from j ava. awt . Conponent ).
Non-visual beans.

BeanInfo
JFormDesigner supports/uses following classes/interfaces specified in the j ava. beans package:

BeanInfo

BeanDescriptor

EventSetDescriptor

PropertyDescriptor

PropertyEditor (incl. support for custom and paintable editors)
Customizer

If you are writing BeanInfo classes for your custom components, you can specify additional information
needed by JFormDesigner using the j ava. beans. Feat ur eDescri pt or extension mechanism.

For example implementations of BeanInfos and PropertyEditors, take a look at the examples in the
exanpl es folder or exanpl es. zi p archive.

Attribute Name Description
isContainer Specifies whether a component is a container or not. A container can have child
(BeanDescriptor) components. The value must be a Bool ean. Default is false. E.g.

beanDesc. set Val ue("i sCont ai ner", Bool ean. TRUE);

containerDelegate If components should be added to a descendant of a container, then it is possible to
(BeanDescriptor) specify a method that returns the container for the children.
JFr ane. get Cont ent Pane() is a example for such a method. The value must be a
St ri ng and specifies the name of a method that takes no arguments and returns a
j ava. awt . Cont ai ner . E.g.

beanDesc. set Val ue( " cont ai ner Del egate", "get ContentPane");
layoutManager Allows the specification of a layout manager, which is used when adding the component
(BeanDescriptor) to a form. If specified, then JFormDesigner does not allow the selection of a layout

manager. The value must be a d ass. E.g.

beanDesc. set Val ue(" | ayout Manager", BorderLayout. cl ass);
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Attribute Name

enumerationValues
(PropertyDescriptor)

extraPersistenceDelegates

(PropertyDescriptor)

imports
(PropertyDescriptor)

notMultiSelection
(PropertyDescriptor)

notNull
(PropertyDescriptor)

notRestoreDefault
(PropertyDescriptor)

persistenceDelegate
(PropertyDescriptor)

readOnly
(PropertyDescriptor)
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Description

Specifies a list of valid property values. The value must be a Obj ect [] . For each
property value, the Cbj ect [ ] must contain three items:

Name: A displayable name for the property value.
Value: The actual property value.
Java Initialization String: A Java code piece used when generating code.

propDesc. set Val ue( " enuner ati onVal ues", new Object[] {
"horizontal", new Integer( JSlider.HORI ZONTAL ),
"JSl i der. HORI ZONTAL",
"vertical", new | nteger( JSlider.VERTICAL ),
"JSlider. VERTI CAL" });

Specifies a list of persistence delegates for classes. The value must be a Cbj ect[] . For
each class, the Obj ect [ ] must contain two items:

Class: The class for which the persistence delegate should be used.

Persistence delegate: Instance of a class, which extends
j ava. beans. Per si st enceDel egat e, that should be used to persist an
instance of the specified class.

Use the attribute "persistenceDelegate” (see below) to specify a persistence delegate for
a property value. Use this attribute to specify persistence delegates for classes that are
referenced by a property value. E.g. if a property value references classes MyClass1 and
MyClass2:

propDesc. set Val ue( " extraPersi st enceDel egat es”, new Object[] {
M/Cl assl. cl ass, new Myd assl1PersistenceDel egate(),
Myd ass2. cl ass, new MyCl ass2Persi st enceDel egate(),

1)

Specifies one or more class hames for which import statements should be generated by
the Java code generator. This is useful if you don't use full qualified class names in
enuner at i onVal ues or PropertyEdi tor. getJavalnitializationString().
The value mustbea Stringor String[].E.g.

propDesc. set Val ue("i nports", "com myconpany. MyConst ants");
propDesc. set Val ue("i nports", new String[] {

"com nmyconpany. MyConst ant s",

"com nyconpany. MyExt endedConst ant s" });

Specifies whether the property is not shown in the Properties view when multiple
components are selected. The value must be a Bool ean. Default is false. E.g.

propDesc. set Val ue("not Mul ti Sel ecti on", Bool ean. TRUE) ;

Specifies that a property can not set to nul | in the Properties view. If true, the Set Value
to null command is disabled. The value must be a Bool ean. Default is false. E.g.

propDesc. set Val ue("not Nul I *, Bool ean. TRUE) ;

Specifies that a property value can not restored to the default in the Properties view. If
true, the Restore Default Value command is disabled. The value must be a Bool ean.
Default is false. E.g.

propDesc. set Val ue(" not RestoreDefaul t", Bool ean. TRUE) ;

Specifies an instance of a class, which extends j ava. beans. Per si st enceDel egat e,
that can be used to persist an instance of a property value. E.g.

propDesc. set Val ue( " per si st enceDel egate", new
MyPr opPer si st enceDel egate());

Specifies that a property is read-only in the Properties view. The value must be a
Bool ean. Default is false. E.g.

propDesc. set Val ue("readOnl y", Bool ean. TRUE);
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Attribute Name Description
transient Specifies that the property value should not persisted and no code should generated. The
(PropertyDescriptor) value must be a Bool ean. Default is false. E.g.

propDesc. set Val ue("transi ent", Bool ean. TRUE);

variableDefault Specifies whether the default property value depends on other property values. The value
(PropertyDescriptor) must be a Bool ean. Default is false. E.g.

propDesc. set Val ue("vari abl eDefault", Bool ean. TRUE);

Design time

JavaBeans support the concept of "design"-mode, when JavaBeans are used in a GUI design tool, and
"run"-mode, when JavaBeans are used in an application.

You can use the method j ava. beans. Beans. i sDesi gnTi me() in your JavaBean to determine whether it
is running in JFormDesigner or in your application.

Reload beans

JFormDesigner supports reloading of JavaBeans.

Stand-alone: Just select View > Refresh from the menu or press F5.
IDE plug-ins: Click the Refresh button in the designer tool bar.
Refresh does following:

1. Create a new class loader for loading JavaBeans, BeanInfos and Icons.
2. Recreates the form in the active Design view.

So you can change the source code of the used JavaBeans, compile them in your IDE and use them in
JFormDesigner without restarting.

Unsupported standard components

* all AWT components
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8 JGoodies Forms & Looks

JFormDesigner supports and uses software provided by JGoodies Karsten Lentzsch.

The JGoodies Forms support is very extensive. Not only the layout manager FormLayout is supported,
also some important helper classes are supported: Bor der s, Conponent Fact ory and For nFact ory
(com.jgoodies.forms.factories).

JGoodies Looks look and feels are built-in so that you can preview your forms using those popular look
and feels. JGoodies Looks examples contains some useful components to build Eclipse like panels:
JGoodies UIF lite.

JGoodies Forms ComponentFactory

The JGoodies Forms ComponentFactory (com.jgoodies.forms.factories) defines three factory methods,
which create components. You find these components in the palette category JGoodies.

“ Label : A label with an optional mnemonic. The mnemonic and mnemonic index are defined by a
single ampersand (&). For example "&Save" or "Save &As". To use the ampersand itself duplicate
it, for example "Look&&Feel".

“ Title: A label that uses the foreground color and font of a Ti t | edBor der with an optional
mnemonic. The mnemonic and mnemonic index are defined by a single ampersand (&).

“ Titled Separator: A labeled separator. Useful to separate paragraphs in a panel, which is often a
better choice than a Ti t | edBor der.

text

JGoodies UIF lite

JFormDesigner supports Si nmpl el nt er nal Frame and Ul FSpl i t Pane from the JGoodies UIF lite package,
which is part of the JGoodies Looks examples. You find both components in the palette category
JGoodies.

Si npl el nt er nal Frane is an Eclipse like frame. Ul FSpl i t Pane is a subclass of JSpl i t Pane that hides the
divider border. Use Ul FSpl i t Pane if you want to put two Si npl el nt er nal Fr anes into a split pane. See
example exanpl es/ Ul FLi t ePanel . j fd.

Propetties
_ | JTree Calar
# | colors '
4 |=portz | | RGE:
+ || food

When using one of these components, you have to add the library

redi st/jgoodies-uif-lite.jar to the classpath of your application. Or add the source code to
your repository and compile it into your application. The source code is in

redi st/jgoodi es-uif-lite-src.zip.

IDE plug-ins: If you use one of the UIF lite components the first time, the JFormDesigner IDE

plug-in ask you whether it should copy the required library (and its source code and
documentation) to the IDE project and add it to the classpath of the IDE project.
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To add a toolbar to a Si npl el nt er nal Frame, add a JTool Bar to the Design view, select the
Si npl el nt er nal Frame, select the "toolBar" property in the Properties view and assign the toolbar to it.

B A
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